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About This Manual
The information in this manual is for informational use only, subject to change without notice, 
and should not be construed as a commitment by NeoPoint. NeoPoint assumes no responsibility 
or liability for any errors or inaccuracies that may appear in this manual.

No part of this manual may be reproduced, stored in a retrieval system, or transmitted, in any 
form or by any means, electronic, mechanical, recording, or otherwise, without the prior written 
permission of Innovative Global Solution, Inc.

Document Number
When ordering or referring to this publication, use the following number:

Publication/PN: NPUG-1001, Rev. 1.03

For information or comments on this manual, please contact NeoPoint Technical Publications or 
visit our web site at: http://www.neopoint.com.

NP1000SW120BLD

Copyrights and Trademarks

Copyright© 1998, 1999 NeoPoint, Inc.

All Rights Reserved.

NeoPoint™, SoftSync™, and the Simply More Intelligent™ are trademarks of NeoPoint, Inc.

T9™ Text Input and Tegic™ are trademarks of Tegic Communications, Inc.

Microsoft® and MS-Outlook™ are trademarks of Microsoft Corporation.
HyperTerminal is a trademark of MicroSoft Corporation and Hilgraeve

ProComm Plus® 32 is a registered trademark of Symantec Corporation

WinFax Pro™ is a trademark of Symantec Corporation.

HotFax™ is a trademark of Smith Micro Software

MiniBrowser™ and Phone.com™ are trademarks of Phone.com, Inc.

All other trademarks belong to their respective companies.

Getting Technical Support
You can contact NeoPoint Technical Support at:

1 (888) 458-4447 (toll free) or via e-mail at solutions@neopoint.com
NeoPoint, Inc.

4225 Executive Square, Suite 600

La Jolla, California 92037

Corporate office: (619) 458-2800

Fax: (619) 458-9588
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FCC & Industry Canada Regulatory Compliance
The NeoPoint phone is approved for use in CDMA networks. This device complies with Part 15 
of the FCC Regulations. Operation of this phone is subject to the condition that it does not cause 
harmful interference.

Your wireless hand-held portable telephone is a low power radio transmitter and receiver. When 
it is ON, it receives and also sends out radio frequency (RF) signals. In August 1996, the 
Federal Communications Commission (FCC) adopted RF exposure guidelines with safety 
levels for hand-held wireless phones. Those guidelines are consistent with safety standards 
previously set by both U.S. and international standards bodies: American National Standard 
Institute (ANSI), National Council of Radiation Protection and Measurements (NCRP), and 
International Commission on Non-Ionizing Radiation Protection (ICNRP). Those standards 
were based on comprehensive and periodic evaluations of the relevant scientific literature. Over 
120 engineers, scientists, and physicians from universities, government health agencies and 
industries reviewed the available body of research to develop the ANSI Standard. The design of 
your phone complies with the FCC guidelines and those standards.

Important: Read “Safety” on page xvii prior to using your NeoPoint 
phone.
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Preface

Daily Applications of Your NeoPoint 1600

Congratulations! Your new NeoPoint 1600 is going to change the way you 
communicate. NeoPoint 1600: a smart, simple solution to your active life style.

NeoPoint 1600 is a compact, lightweight personal communications system with 
added features for the person on the go. More than just a mobile phone, the NeoPoint 
1600 phone allows you to:

• Access your e-mail, voicemail, and text messages

• Experience greater coverage as this dual-mode phone supports both analog and 
digital modes

• Track your outgoing and incoming calls for future reference or call back

• Schedule and organize names and numbers (referred to as contacts)

• Track appointments and meetings (keep your schedule everywhere you go)

• Go on-line through the MiniBrowser (depending on your carrier service - surf the 
web, get e-mails, stock quotes, etc.)

• Transfer contacts, schedule, and to do data between your PC and NeoPoint 1600 
phone

• Transfer files from your laptop PC to your NeoPoint 1600 and onto your PC

These are just a few of the many features available with your NeoPoint 1600 mobile 
phone - all without a bulky appointment book or a personal digital assistant.

NeoPoint - your new point of communication.
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Overview of This Manual

This manual is intended for use with the NeoPoint 1600 phone. The following table 
lists each chapter with a brief description.

Chapter Title Description

Chapter 1: Getting 
Started

Provides a quick start checklist and a brief introduction that 
helps you get started using your NeoPoint 1600 phone.

Chapter 2: NeoPoint 
Menu Applications

Provides a brief overview of the NeoPoint 1600 menus and 
features.

Chapter 3: Syncing 
Your NeoPoint Phone

Provides information on how to install the SoftSync 
software, connect the NeoPoint phone to your PC, and how 
to transfer or sync your data files.

Chapter 4: Using 
Your NeoPoint Phone

Contains task-oriented features and functionality of the 
phone. For example: how to place a call, how to create a 
voice command, etc.

Chapter 5: NeoPoint 
Care and 
Troubleshooting

Guides you step-by-step on troubleshooting common 
problems you may experience while using your phone. It 
also includes service information for your NeoPoint phone.

Chapter 6: 
Accessories

Provides information on optional accessories for your 
NeoPoint phone.

Chapter 7: Did You 
Know...

Provides information on how to get the most use out of your 
NeoPoint.

Appendix A: 
Receiving and 
Sending Fax and Data 
Calls

Provides information on how to setup, send, and receive data 
and fax calls your NeoPoint (wireless modem) phone.

Appendix B: Using the 
MiniBrowser

Provides information on how to send/receive e-mail, search 
the web for sites/services, and make bookmarks using the 
MiniBrowser feature of your NeoPoint phone.
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Dual-Mode

The NeoPoint 1600 is a cellular band, dual-mode wireless phone, compatible with 
both digital (CDMA) and analog (AMPS) networks operating at 800MHz

The term dual-mode represents the ability of your NeoPoint 1600 to transmit and 
receive signals from both analog and digital cellular phone systems.. 

The benefits of having a dual-mode phone include being able to use your phone when 
traveling and in an area where CDMA digital is not yet activated. Your NeoPoint 
1600 phone will automatically find an analog cell site, allowing the call to be 
processed.

About CDMA...

Code division multiple access (CDMA) is the type of digital wireless transmission 
that the NeoPoint phone employs. The following sections provide information on 
CDMA performance and advantages. These sections are designed to help you 
understand how to better use your NeoPoint phone.

Signal Strength and Phone Performance

Like other portable wireless phones, signal strength is affected by the surrounding 
environment of the user. Buildings, parking garages, elevators, and basements are 
some examples of structures that reduce signal strength. Problems initializing a call, 
muting of the audio during a call, or a call drop are signs of low signal strength. 
Moving toward a window (if indoors) or open space (if outside) and extending the 
antenna fully are ways to optimize signal strength. Traveling in a vehicle through 
varying terrain, tunnels, and tall buildings may also cause rapid changes in signal 
strength.

CDMA Advantages

Security Each conversation is digitized and encoded with a separate 
assigned key to prevent eavesdropping.

Voice Clarity Uses digital voice coding techniques to enhance quality and 
reduce background noise.

Lower Average Using sophisticated power control, the phone transmits the
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Transmit Power minimum power required to communicate with the base 
station and actually idles in between spoken words. This 
results in much lower average power radiating from the 
antenna than other technologies.

Increased System Provides 3-10 times the capacity compared to other
Capacity technologies. This results in fewer dropped calls and system 

busy signals for the user.

Digital Services Allows user new services including caller ID, data and Fax, 
text messaging, and simultaneous voice and data.
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Safety

Important!

Read these safety guidelines prior to using your phone. Failure to follow 
these rules and guidelines may be dangerous and illegal.

Road Safety Information

Do not use a hand-held telephone while driving a vehicle. Talking on the 
phone while driving is dangerous and illegal in some states. If using a 
hand-held phone, park the vehicle before conversing. Remember - road 
safety always comes first!

If you must drive and use your digital wireless phone, purchase and install 
the Hands-Free Kit accessory. For more information on the Hands-Free 
Kit, refer to “Hands-Free Kit For Your Automobile” on page 106.

Aircraft Safety Information

Power down your phone prior to boarding an aircraft. Sending and 
receiving calls on your phone on an aircraft is prohibited by law. Using a 
wireless telephone in an aircraft may interfere with aircraft radio 
communication or navigation equipment, disrupt the wireless telephone 
network, and is illegal. When boarding an aircraft, set your NeoPoint to 
“Power Off.”

Hospital & Medical Safety Information

Power down your phone prior to entering hospitals, health care facilities, or 
when near medical equipment. Operating any radio transmitting 
equipment, including digital wireless phones, may interfere with RF-
sensitive medical devices. Follow all posted regulations while in hospitals 
and health care facilities regarding the use of your phone.
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Blasting and Refueling Safety Information

Do not use your phone near a blasting site. Power down your phone when 
in any area with a potentially explosive atmosphere. Radio transmissions in 
such areas could cause an explosion or fire, resulting in bodily injury or 
even death. Obey all posted signs and instructions regarding the use of 
wireless phone usage.

Observe restrictions on the use of radio equipment in fuel depots (fuel 
storage and distribution areas), chemical plants or where blasting 
operations are in progress.

Interference Safety Information

All mobile phones are subject to radio frequency interference that could 
affect the performance of your phone. Your digital wireless phone is a low 
power radio transmitter and receiver. The design of your phone complies 
with the FCC guidelines and those standards.

Never rely solely on your phone for essential communications (e.g., 
medical emergencies). You must be in a service area with adequate signal 
strength to use the phone. Emergency calls may not be possible on all 
wireless phone networks or when certain network services and/or phone 
features are in use. Check with your local service provider(s).

Service Safety Information

Only qualified service personnel are authorized to repair your digital 
wireless phone and equipment. Use only approved accessories and 
batteries. Refer to "Chapter 5: NeoPoint Care and Troubleshooting" on 
page 95 for more information.
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1

Chapter 1: Getting Started

Overview

This chapter is divided into three sections: 

• Battery Installation and Charging

• NeoPoint Phone Description

• Basic NeoPoint Phone Operation

1
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1

Battery Installation and Charging

Before you can use your NeoPoint phone, you must install and charge your battery.

Inserting Your Battery

To insert the battery into the phone, you need to align the battery alignment slots.

Insert the top of the battery into the top of the battery slot at a slight angle. 
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Once the top is inserted, lay the battery flat into the battery slot and push forward 
until the battery clicks and locks into place.
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1

Charging Your Battery

1. Insert one end of the travel charger into your NeoPoint phone.
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2. Flip the plug prongs out and plug into the socket.

Your phone will begin charging. Approximate charging time for the batteries are:

Slim Battery 90% charged 1.5 hrs (approx.)

Extended Battery 90% charged 2 hrs (approx.)

Once your phone is charged, you can begin normal use. The following section 
describes the components of your NeoPoint phone.
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1

NeoPoint Phone Description

The following shows key components of the NeoPoint phone. 

1) Power On/Off Key  6) Main/Menu Key 11) End Key

2) Call Indicator Light  7) Send Key 12) Back Key

3) Volume/Scrolling Keys  8) Flip Button & Pin 13) Soft Key 2

4) Navigator Key  9) Flip 14) Display Screen

5) Soft Key 1 10)Microphone 15) Ear Piece

1

2

7

6

5

4

3

8

12

11

15

14

13

10

9
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Key Functions

The following describes keys and their functions.

Power On/Off Key

The Power On/Off key performs two functions: powering the phone on or off and 
accesses Quick Mode.

Power On With the phone off, press the Power On/Off key. The phone will 
power on, momentarily display the IGS Splash screen, and then 
display the NeoPoint Main screen.

Power Off With the phone on, press and hold the Power On/Off key until the 
display shows the confirmation: “Powering down” and then release 
the key.

Quick Mode is accessed by pressing the Power On/Off key while the phone is on. 
Once accessed, the following options are displayed:

• Power Off

• Enable/Disable Keyguard

• Lock/Unlock the Phone

• Mode (Normal, Silent, PDA)

• Incoming (Voice, Data In, Fax In)

For more information on the functions and how to use Quick Mode, refer to “Using 
Quick Mode” on page 66.

Volume/Scrolling Keys

The Volume/Scrolling keys serve three different functions:

• Adjusting volume for the keypad, ear piece and ringer

• Activating a voice command

• Scrolling pages in the applications

Volume Up Press the VOLUME UP key

Volume Down Press the VOLUME DOWN key

Voice Command Press & momentarily hold either the VOLUME UP or VOLUME 
DOWN key. The phone will prompt you to say the voice 
command.

For more information on voice commands, refer to “Creating a Voice Command” on 
page 89 and “Using a Voice Command” on page 90.
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1

Scrolling Pages When in an application (Contacts, Schedule, To Do, etc.) that 
contains more entries than the screen can display, press the 
VOLUME UP or VOLUME DOWN keys to scroll through the 
entries.

Navigator Key

The Navigator key is located below the display screen. It is a four-way button used to 
move the cursor up, down, left, and right. If you press on the left side of the key, the 
cursor will scroll to the left (providing it has that option). Use this key to navigate 
through the menus, applications, and lists within the applications. From the Main 
screen, the Navigator key is preset to go directly to specific applications. For more 
information on accessing applications using the Navigator key from the Main screen, 
refer to “Main Screen” on page 35.

Soft Keys 1 & 2

Your phone has two soft keys with up arrows that are located on both sides of the 
Navigator key. Their functions are indicated by the words appearing above them on 
the screen display. The functions for these keys change, depending on the specific 
application.

Main/Menu and Back Keys

The Main/Menu and Back keys are located on the outside of either side of the soft 
key. 

The Main/Menu key (marked with an M) has two functions:

1. Toggles between the Main and Menu screens

2. Provides quick access to the Main screen from any application

The Back key (marked with a B) returns to the previous screen until you reach the 
Main screen.

SEND, CLR, and END Keys

SEND Initiates a call.

To place a call, dial the number you want to call and press SEND. 
The phone will initiate the call.

To receive an incoming call, press SEND (or IGNORE to send to 
voicemail).

To call the last number you dialed (to redial), press the SEND key 
twice. The phone will access the Call History application and 
initiate a call with the first number on the list.
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To place a call from within an application, select the number and 
press the SEND key.

CLR Clears the last-entered character, or the character located to the left 
of the cursor. Press and hold will clear all characters in a field.

END Terminates the call.

SHIFT, NEXT, and SPACE Keys

These keys are used in conjunction with specific features. The functions of these keys 
change based on the specific feature. The following table displays the different key 
modes and the action that occurs when you press one of the three buttons. 

The SPACE key is also used to create HotKeys and Voice Commands. For more 
information on HotKeys, refer to “Creating a HotKey” on page 91 and . For more 
information on Voice Commands, refer to “Creating a Voice Command” on page 89 
and “Using a Voice Command” on page 90.

Key 
Mode/
Action

ALPHA alpha T9 t9 NUM SYM

PRESSING 
SHIFT

toggles
 alpha 
(lower 
case)

toggles
ALPHA 
(upper 
case)

toggles
 t9

 (lower 
case)

toggles
 T9 

(upper 
case)

* *

PRESSING 
NEXT

0 0 next word next word 0 N/A

PRESSING 
SPACE

space space space space space #
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1

Display Screen

The Display Screen features many onscreen indicators and one-touch navigation to 
applications. The following provides a brief definition of each onscreen icon:

The NeoPoint phone opens with the Main screen:

Schedule

To Do

Your Phone Number

Call History

MiniBrowser

Contacts

Signal Strength

New Voicemail

Battery Strength

Inbox

New Text Message
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Main and Menu Screens

There are two screens that allow you access to the applications when using the 
NeoPoint phone: Main Screen and Menu Screen.

Main Screen Displayed after powering on the NeoPoint phone. This screen 
displays several onscreen icons (refer to the next section for a 
description of onscreen icons) and allows access to six applications 
with one touch of a button.For more information on the Main 
screen, refer to “Main Screen” on page 35.

Menu Screen Displays the list of the nine NeoPoint applications. These 
applications allow you to maximize using the NeoPoint phone. for 
more information on Menu screen and applications, refer to “Menu 
Applications” on page 37.

You can switch between the two screens by pressing the  MAIN/MENU KEY.

Main Menu
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1

Onscreen Icons

 The main screen displays several onscreen icons: the following describes 
each of the onscreen icons you may see on the NeoPoint phone:

Signal Strength
Displays the strength of the signal being received by the phone.

No Service
The phone is not receiving a signal from the network, which may be the 
result of one of the following:
Searching for system
No service

New Voicemail
A voicemail message has been received.

New Text Message
A text message has been received.

Battery Strength
Indicates the battery charge level.

Phone
The Phone icon is displayed in the upper right corner of the phone when 
you enter a field that has a number that can be dialed.

Locked Phone
Indicates that the phone is locked, and cannot be used without the proper 
lock code.

Incoming Fax or Data Mode
Indicates that the phone is in the incoming fax or data mode.

New E-Mail
The E-mail icon is displayed in the upper right corner of the phone when 
you enter a field that has an e-mail address.

NO
SVC
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Recurring Event
Indicates that the scheduled event is a recurring event (daily, 4th Tuesday, 
4th Friday, each 23rd, never, weekly, yearly).

All Day Event
Indicates that the scheduled event is an all day event.

Event Alarm
Indicates that the scheduled event has an alarm set.

Inbox
Accesses the Inbox screen and allows you to view and/or retrieve your 
voicemail, text messages, and e-mail.

Call History
Accesses the Call History screen and allows you to view all call 
information, save call information, etc.

Contacts
Accesses the Contacts screen and allows you to create and maintain a list 
of approximately 1,000 contacts, including names, numbers, addresses, 
etc.

Schedule
Accesses the Schedule screen and allows you to create and maintain all 
of your appointments, set alarms, etc., for months in advance.

To Do
Accesses the To Do screen and allows you to create and maintain a list of 
“to do” items, with priorities, etc.

MiniBrowser
Accesses the MiniBrowser screen and allows you to surf the Internet via 
specially-designed web pages for cellular telephones.

Sync
Accesses the Sync screen and allows you to transfer information between 
your NeoPoint and your PC/Laptop.
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Entering Text, Number, and Symbol Characters

The NeoPoint has four modes for enter characters: 

• ALPHA/alpha Upper and Lowercase letters

• T9/t9 “Smart” word entry

• NUM Numbers

• SYM Symbols/Special Characters

ALPHA/alpha Mode

ALPHA/alpha mode (UPPER/lower case) allows you to enter alphabetic characters 
using the multi-tap method. The multi-tap method is designed around the keypad 
and it has several letters associated with each key. For example, the number 2 has the 
letters “A,” “B,”, and “C” associated with it.

To type a word - for example, the word Hello, you would use the following multi-tap 
sequence on the keypad: 4-4, 3-3, 5-5-5-, 5-5-5, 6-6-6, where dashed numbers (4-4, 
etc.) are pressed without pausing. Pausing between pressing the keys may move the 
cursor to the next letter. If this happens, press the CLR key to clear the letter and try 
again.

ALPHA/alpha mode will automatically begin in uppercase at the beginning of each 
data entry and switch to lowercase with the next letter. If you wish to toggle between 
upper/lower case, press the SHIFT key on the key pad.

T9 Mode

T9 (Text for 9 keys) Mode (or t9 mode - depending on whether you are in UPPER or 
lower case) employs an intelligent software protocol that allows you to enter text just 
as you would on a desktop keyboard. Press one key for each letter and type the 
entire word. Although each key contains multiple letters (the “5” key, for example, 
can be used to type “J”, “K”, or “L”) T9 automatically matches your keystrokes with 

Preferences
Accesses the Preferences screen and allows you to customize your 
NeoPoint to suit your needs.

More...
Accesses the More... screen and allows to access your carrier service 
provider services.
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words in an internal database to determine the word you are typing. T9 will select the 
matching word that is most often used.

When in data entry mode and T9 appears in the bottom right of the display, you may 
enter the word. If it is not displayed, press SOFT KEY 2 until the T9 mode indicator 
appears. The following example demonstrates how you can practice using T9 mode.

1. Once you are in T9 mode, type the entire word, using one key press per letter. 
The word “hello” is entered by pressing keys 4, 3, 5, 5, 6 in that order.

As you type, T9 matches the keys you pressed with words from its database. 
Because T9 is working to match your keystrokes, different words may appear as 
you are typing. Most likely, your desired word appears after you spell it 
completely.

2. If the word you want is not displayed, press NEXT to display alternate word 
choices.

Short words are more likely to share the same keystroke sequences. For 
example, book and cool both use the sequence 2, 6, 6, 5. T9 displays the more 
commonly used word book. To display “cool” - press NEXT. You may cycle 
through all the choices for a keystroke sequence by pressing NEXT repeatedly.

3. Press SPACE when the word you desire appears in the display, to accept it and 
continue typing the next word.

4. If your word is not one of the alternate word choices, adding words to the T9 
database is easy.

Switch to Alpha mode, type the word using the multi-tap method, and then 
switch back to T9. The word is saved automatically and will appear as a word 
choice in T9, the next time you want to type it. You may need to press NEXT to 
display the new word if other words share the same keystroke sequence.

5. In T9, “Smart Punctuation” is available on the 1 key. This enables you to type 
e-mail domains, possessive forms, and contractions quickly and easily. At first, 
T9 displays a period. However, T9 uses some simple rules to determine and 
display the appropriate mark as you continue to type. In a message, try typing 
“it's easy.” 

Press the following keys in order: 4, 8, 1, 7, #SPACE, 3, 2, 7, 9, 1
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Try another example by typing the e-mail address: john@company.com

1. Enter the username john in t9 mode.

2. Press SOFT KEY 2 to toggle to SYM (Symbols) mode. Using the NAVIGATOR 
key to move the cursor to select the @ symbol. Press Select (Soft Key 1). The 
phone automatically returns to t9 mode, and t9 appears in the lower right corner 
of the display.

3. Enter company.com by pressing the following keys, in order: 2, 6, 6, 7, 2, 6, 9, 
1, 2, 6, 6. You should now see john@company.com in the field.

Visit the website: www.t9.com for more information on T9 text input mode.

NUM Mode

NUM (Number) mode allows you to enter numbers in Contacts, Schedule, and To Do 
applications. 

To toggle to NUM mode in an entry field, press SOFT KEY 2 until NUM mode is 
displayed at the bottom right corner of the screen.

SYM Mode and Special Characters

There are two ways to type special characters: 

• Using the SYM (Symbol) mode by pressing SOFT KEY 2 and then using the 
NAVIGATOR KEY to select the character. 

or

• Pressing the 1 key

Using the SYM mode will display the following pop-up window:

Use the NAVIGATOR key to select the character and press SELECT (Soft Key 1).

In ALPHA/alpha mode, continuously pressing 1 will display the following 
characters/choices (in the same position):

. , - ‘ @ / ~ : ? 1
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Once you have the desired symbol, you can wait momentarily to enter the next 
character or change modes.

Basic NeoPoint Operation

Main Screen

The NeoPoint phone opens with the Main screen:

The Main screen allows direct access to six menu applications by pressing the 
NAVIGATOR key, SOFT KEY 1, or SOFT KEY 2.

Accessing Menu Applications From Main Screen

As shown in the previous illustration, you can access the following applications from 
the Main screen:

• UP NAVIGATOR KEY accesses Schedule application. For more 
information on the Schedule application, refer to 
“Schedule” on page 46.

• RIGHT NAVIGATOR KEY accesses the To Do application. For more 
information on the To Do application, refer to “To 
Do” on page 44.

• DOWN NAVIGATOR KEY accesses the Contacts application. For more 
information on the Contacts application, refer to 
“Contacts” on page 44.

• LEFT NAVIGATOR KEY accesses the MiniBrowser application. For more 
information on the MiniBrowser application, refer to 
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“MiniBrowser” on page 44.

• SOFT KEY 1 accesses the Call History application. For more 
information on the Call History application, refer to 
“Call History” on page 45.

• SOFT KEY 2 accesses the Inbox application. For more 
information on the Inbox application, refer to 
“Inbox” on page 44.

•  MAIN/MENU KEY Accesses the Main screen from any application and 
toggles between the Main and Menu screens.

•  BACK KEY accesses the Main screen or previous screen.

Menu Screen

There are nine applications on the Menu screen.

You can change the Menu screen to display the menu items in either list or icon form. 
Both screens are shown here. To change the Menu screen to display either List or 
Icons, refer to “Changing the Menu Screen to Display List or Icons” on page 82.

List Icons

Changes to
display selected
application. 
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Menu Applications

The following table lists each application with a brief description:

Application Description

Inbox Provides access to voicemail and text 
messages. For a brief description, refer to 
“Inbox” on page 44. For procedural 
information, refer to “Using Inbox” on page 69.

Call History Tracks all calls, including incoming, outgoing, 
missed, and failed. For a brief description, refer 
to “Call History” on page 44. For procedural 
information, refer to “Using Call History” on 
page 73.

Contacts Stores up to 1000 contacts, each with 
addresses, multiple telephone numbers, e-mail, 
web page, and other information. For a brief 
description, refer to “Contacts” on page 44. For 
procedural information, refer to “Using 
Contacts” on page 74.

Schedule Calendar with daily and monthly scheduling 
capabilities. For a brief description, refer to 
“Schedule” on page 44. For procedural 
information, refer to “Using Schedule” on page 
75.

To Do Helps organize and prioritize your tasks. For a 
brief description, refer to “To Do” on page 44. 
For procedural information, refer to “Using To 
Do” on page 77.
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Making a Call...

There are several different methods for placing a call. You can place a call from the 
Main, Call History, Contacts, Text Messages, To Do, and Schedule screens.

From the Main Screen

1. Open the flip.

2. Dial the telephone number.

3. Press the SEND key.

MiniBrowser Connects to your carrier service provider’s 
Internet server and allows limited Internet 
access. Internet access information is provided 
by your carrier service provider. For a brief 
description, refer to “MiniBrowser” on page 
44. For procedural information, refer to 
“Appendix B: Using the MiniBrowser” on page 
131.

Sync Allows you to transfer and update Contacts, 
Schedule, and To Do information between your 
NeoPoint phone and your PC. For a brief 
description, refer to “Sync” on page 44. For 
procedural information, refer to “Using Sync” 
on page 78.

Preferences Allows you to change your phone settings to fit 
your needs. For a brief description, refer to 
“Preferences” on page 44. For procedural 
information, refer to “Using Preferences” on 
page 78.

More Displays applications including voice 
commands, hot keys, carrier services, timers, 
clock settings, and manufacturing information. 
For a brief description, refer to “More...” on 
page 44. For procedural information, refer to 
“Using More...” on page 89.

Application Description
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4-Digit Dialing

The NeoPoint phone allows you to dial the last four digits of a phone number, given 
the number has been programmed into Contacts. For more information programming 
a contact, refer to “Using Contacts” on page 74.

Answering a Call

When the phone rings, the phone will indicate that you have an incoming call by:

• Ringing

• Flashing the call indicator light

• Displaying an onscreen message “Incoming call from 234-456-7890 (the caller’s 
number or restricted if blocked)

You have the following options:

• Press the SEND key (while the flip is open) or Soft Key 1 while indicating Send 
function

or

• Open the flip (when Active Flip is On)
or

• Press any key (except for the power and volume keys and when Anykey Answer is 
On) to answer the call

or

• Press Ignore (Soft Key 2) to send the call to voicemail

NOTE:The Anykey Answer and Active Flip factory default settings are 
On. To disable these features, refer to “Enabling/Disabling Anykey 
Answer” on page 86 and “Enabling/Disabling Active Flip” on page 86. 
By disable these features, the first two methods of answering a call will 
not work.
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Ending a Call

After concluding your conversation, you can end your call by performing one of the 
following three options:

• Press the END key

or

• Press End (Soft Key 1) to terminate your call

or

• Close the flip of your phone

NOTE: If you have set the Active Flip feature to Off, closing the flip will 
not terminate your call.

Redialing

1. From the Main screen, with the flip open, press the SEND key. This takes you to 
the Call History screen, displays the Call History list, and selects the last call 
you made on your phone.

or

2. From the Main screen, with the flip closed, you can press the Soft Key 1 twice.

3. Press the SEND key again to dial and connect the call. 

Making a Three-Way Call

Three-way calling allows you to talk with two people at the same time.

1. Dial the first number and press the SEND key.

2. After the first call connects, dial the second number.

3. Press the SEND key. (The first number you called is now placed on hold.)

4. Once the second call is connected, press the SEND key again. The conference 
call is now in progress.
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NOTE:If you press the END key or close the flip with Active Flip On 
to terminate a conference call, the connection between the other two 
parties will terminate. However, if one of the two parties terminates a 
call, it will not affect the connection between you and the remaining 
party.

Call Waiting

Call waiting is a feature offered by your carrier service provider. Call waiting is when 
you are on a current call and you receive an incoming call. On the NeoPoint phone, 
you will hear a click through the ear piece indicating that you are receiving another 
call. To answer this second call or call waiting, use the following procedure:

1. Press SEND to answer the second call. The phone connects to the second party, 
placing the first party on hold.

2. Press SEND again to switch to the first call.

3. Press END when finished with the call.
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Chapter 2: NeoPoint Menu
Applications

Overview

This chapter discusses the NeoPoint Menu applications. The Menu screen contains 
nine main applications. Each of these nine applications and their options are 
discussed in the following sections.

Menu Screen

There are nine applications on the Menu screen.

You can change the Menu screen to display the menu items in either list or icon form. 
Both screens are shown here. To change the Menu screen to display either List or 
Icons, refer to “Changing the Menu Screen to Display List or Icons” on page 82.

List Icons

Changes to
display selected
application. 

1
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The nine applications of the NeoPoint are:

• Inbox

• Call History

• Contacts

• Schedule

• To Do

• MiniBrowser

• Sync

• Preferences

• More...

The following sections describe each of the applications.

Inbox

Voicemail is controlled by your carrier service provider. 
Each voicemail message is stored at the carrier server 
and accessed through a phone call to the mailbox at the 
server. Text messages are sent and stored on your phone.

When a message is sent to your phone, an onscreen 
message and icon appears notifying you of new 
messages in your Inbox. The icons are:

Voicemail

E-mail

Text messages

While voicemail is selected, Soft keys 1 and 2 display LISTEN and VIEW options. 
When text message is selected, Soft key 1 displays VIEW.

Inbox can hold up to 99 messages before it begins overwriting messages. Inbox will 
overwrite the oldest message. You can lock your text message to avoid the message 
being overwritten. Voicemail is carrier service dependent and the number of 
voicemails is not NeoPoint-dependent. Refer to “Using Inbox” on page 69 for 
information on voicemail and text message options.
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Call History

Call History allows you to view all types of calls at the 
touch of a finger. When selected, it displays the last 30 
numbers called with a maximum of five calls per number. 
These calls are divided into four types of calls:

• incoming

• outgoing

• data

• missed

The type of call is indicated by the letter in front of the 
call, e.g., i for incoming, o for outgoing, d for data, and m 
for missed.

As you scroll through the list of calls, the number for each call and name of contact 
(provided the call was initiated or received from a known contact) is displayed. If the 
call was not initiated or received from a known contact, only the telephone number is 
displayed. Once you exceed the 30-number storage limit, the oldest call history 
record is overwritten.

Pressing Options (Soft Key 2) displays the Options pop-up menu. This menu 
includes the following options:

Detail Displays call information, i.e., phone number, date, time, call type: 
i, o, d, m, and elapsed time.

Save number Transfers phone number to Contacts. Requests you select number 
type: home, work, mobile, other, and then goes to Contacts where you 
can enter more information.

Delete Deletes record of the selected number

Delete all Deletes all numbers in Call History

Refer to “Using Call History” on page 73 for information on how to save, delete, or 
view detailed call information.
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Contacts

You can store approximately 1000 contacts in your 
NeoPoint phone (depending on amount of data per 
contact). Each contact can include:
• First & last name
• Title & company
• Work, home, fax, mobile & other phone numbers
• Business or home address
• Web site & e-mail address
• Note/other information

When a contact is selected, the name is displayed in bold and Soft Keys 1 & 2 change 
to Detail, Send, and Mail (if it is an e-mail). Also, the type of number, e.g., home, 
work, fax, mobile, other is shown with a letter (h, w, f, m, o) on the left side of the 
contact number. The E-mail icon  will be displayed if it is the e-mail address.

NOTE:Whenever you see the phone icon  in the upper right corner of the 
screen, you can press SEND key on the key pad to place a call to the cursor-
indicated number.

Refer to “Using Contacts” on page 74 for information on how to create and use 
contacts.

Schedule

The Schedule application allows you to keep track of 
appointments. When you select Schedule from the Menu 
screen, Today’s view will appear by default. This view 
shows the event(s) scheduled for that day. Each event has 
the following settings:
• Subject Title of event
• Time Time of day the event will occur
• Length How long the event is planned (mins., hrs.). 

If the event is scheduled for all day, the All 
Day  icon will be displayed.

• Repeat If event will repeat (weekly, monthly, etc.) 
and is shown as circular arrows  on the 
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left side of the event name.
• Alarm Sounds alarm (5, 10, mins. prior, etc.) and is 

shown as a bell  on the left side of the 
event time.

• Note Notes about the event.

To view the scheduled items for the month, press 
Month (Soft Key 2) from the Today view.

In the Month view, a day with scheduled items will have 
the date underlined: e.g., 25.

Refer to “Using Schedule” on page 75 for procedural 
information.

To Do

The To Do feature helps you to organize and prioritize 
your tasks. This feature allows you to set the following 
parameters for each task:

Priority High, Medium, Low

Subject Title of task

Status Open or Done

Note Write a brief note regarding this task

Once you have created a list of To Do tasks, as you scroll 
through the list, each item will display the title, priority, 
and status.
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Once you complete the To Do task and change the status 
to Done, a check mark  will appear to the left of the 
subject task name.

Refer to “Using To Do” on page 77 for procedural 
information.

MiniBrowser

The MiniBrowser feature allows you to view internet 
content specially designed for mobile phone interface. 
Access and selections within this feature are service 
provider-dependent.

For specific information on MiniBrowser access 
through your NeoPoint phone, refer to your service 
provider. 

Refer to “Using MiniBrowser” on page 78 for more 
information.

Sync

The Sync feature allows you to connect and transfer data 
between your NeoPoint phone and your PC by 
performing the following:

1. You must first install the NeoPoint SoftSync 
software on your PC.

2. Next, you need to connect the nine-pin serial port 
connector end of your SoftSync cable to your PC 
and the other end to your NeoPoint phone.
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3. Finally, you need to have MS-Outlook or other NeoPoint-compatible personal 
information management (PIM) software installed on your PC. Refer to 
www.neopoint.com for a complete list of compatible PIM software.

Refer to “Syncing the Phone with Your PC” on page 60 for procedural information.

Preferences

The Preferences menu allows you to access several 
options that you may want to change periodically. The 
following sections describe each of these options. 

Use the NAVIGATOR key to scroll to a menu item. Press 
SELECT to view the menu item.

Refer to “Using Preferences” on page 78 for procedural 
information.

Ringer Type

There are six settings in Ringer Type: Calls, MiniBrowser, Message, Voicemail, 
Scheduler, Roam Call. Ringer Type allows you to customize a different tone for 
each setting. You can choose any of the 11 different ringer tones:

Basic Susanna Elise

Green Anthem Phantom

None Beep Slots

Parrot Jackpot

Use the Navigator key to scroll and change ringer types. Once you highlight an 
option, use the left/right Navigator key to change to a different ringer tone. Once you 
have made your selection, press DONE.

Volume

There are three options where you can control the volume:

Ringer Off and 1-6 (low to high)

Ear Piece 1-6 (low to high)

Key Pad Off, Low, and High
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Key Beep

There are two options in Key Beep:

Key Tone Tones or Click

DTMF Length Short or Long

When you are experiencing problems connecting to a number, it may be because the 
dual tone modulated frequency (DTMF) length is too short. If the tones are too short 
for the system to recognize the tones for the number you are trying to reach, the 
number will not connect. This problem is usually experienced when you have a very 
weak carrier signal.

Try changing the setting the DTMF length from Short to Long length. This will 
lengthen the DTMF tone, allow the system to recognize the tones, and help connect 
your call through the cellular network.

Press DONE when finished.

Alerts

There are three features in the Alerts menu. These features allow you set alerts to 
notify you of a change, e.g., when you lose or regain carrier service signal. These 
features are:

Roam Beep On/Off. This feature alerts you when your service changes to 
roaming (out of your normal area).

Service Change On/Off. This feature sounds a tone notifying you when you 
lose/regain a service signal to your phone.

MiniBrowser On/Off. This feature sounds an alarm when you receive e-mail 
or other MiniBrowser-definable settings. Refer to “Appendix 
B: Using the MiniBrowser” on page 117 for more information 
regarding MiniBrowser options.

Press Done when finished.

Main Screen

The Main Screen menu has the following settings:

Phone Number On/Off. This feature displays/removes your phone number 
from the Main screen.

Time Format 12 or 24 hr. This feature changes the time format to display 
either 12 hour or 24 hour format.
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Next Event On/Off. This feature displays next scheduled event on the 
Main screen.

Soft Keys 1 & 2, Navigator Left/Right/Up/Down keys are user-definable. You can 
set these keys to any application or feature of the phone. For example, you can set the 
Left Navigator key to call your home number or set Soft Key 1 to access your 
security screen. The settings shown are factory default settings.

Press DONE when changes are complete.

Display

The Display menu has four features that allow you customize display settings to suit 
your individual needs. These features are:

Backlight Off, 5, 10, 15, 30 secs. and On. Sets the length of time the 
display is illuminated after the last key is pushed or flip is 
opened.

Note: Setting this feature to On will deplete your battery 
charge at a faster rate.

Contrast 0 - 10. This feature allows you to change the contrast from 0 
(lightest) to 10 (darkest).

Night Light Off, 15 secs, 30 secs, or 1 min. This feature sets the length of 
time the keypad is illuminated. When not turned Off, this 
feature is activated from the hours of 5 PM to 5 AM whenever 
your flip is open.

Menu Screen List or Icons format. This feature changes the Menu screen 
from List form to Icons.

Press DONE when changes are complete.

Security

Security feature helps you to protect your phone from unauthorized use. To access 
this screen, you must enter the 4-digit security code (default = last 4-digits of your 
phone number).

Lock Code Enabled or Disabled. Enabled is the default setting. Use to 
lock your phone and enter the Security screen (when enabled).

Also used to change your current lock code. Press Edit (Soft 
key 2) to change your lock code and Done when finished.
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Power-up Lock Yes or No. Once set, this feature locks your NeoPoint phone 
every time your phone is powered on.

Emergency List Allows you to preprogram four emergency numbers that can 
be dialed when the phone is locked. Refer to “Creating and 
Editing an Emergency List” on page 83 for information on 
how to create an emergency list.

NOTE:It is recommended that you include the number to your carrier 
service provider in your emergency list. This allows you to make calls to your 
provider even if your phone is locked, you cannot remember your password, 
are experiencing phone difficulties, etc.

Defaults Resets all user settings to default settings. Before using this 
feature, it is recommended that you refer to “Default Settings” 
on page 84.

Database Clears all information records from Contacts, Schedule, To 
Do, Voice Commands, and HotKey applications and features. 
All user data is erased.

General

The General menu has the following options:

Active Flip On/Off. This feature is allows you to answer a call by opening 
the flip or end a call by closing the flip.

Anykey Answer On/Off. This feature allows you to answer an incoming call by 
pressing any key except: Power On/Off key, the Volume 
keys, Ignore (Soft Key 2) or End key.

Sync Manual/Auto (automatic). To use this feature, your NeoPoint 
phone must be in one of the two following configurations:

1. Connect to your PC via the SoftSync cable.

2. Inserted into your optional Docking Station that is 
connected to your PC via the SoftSync cable.

This feature allows you to initiate a sync when you either 
manually click onto the SoftSync icon or automatically when 
you connect/insert the phone.

Power Save On/Off. When On, turns LCD off after 5 minutes of no use. 
This helps to conserve battery usage.
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Car AutoAnswr On/Off. This feature is used with the Hands-Free Kit. When 
On, this features allows automatic answering while in your 
automobile. For more information, refer to “Activating/
Deactivating Car Auto Answer” on page 87 and “Hands-Free 
Kit For Your Automobile” on page 106.

Wakeup Alarm Allows you to turn on or off alarm notifications. When your 
NeoPoint is powered OFF, Wakeup Alarm is set to ON, and 
Schedule has an event with alarm set to ring, your phone will 
“wakeup” and sound the alarm. If there is no action (pressing 
keys, etc.) for 3 minutes, the phone will power OFF.

NetGuard Allows you to choose whether you want the prompt window 
“Enter Wireless Internet?” to be displayed when using the 
MiniBrowser or launch the MiniBrowser/Wireless Internet 
without the prompt.

Banner

Banner allows you to enter or change the 15-character field displayed on the Main 
screen. Using capitol letters affects what is seen on the display screen and may cause 
the last letter(s) not to appear.

Press DONE to save the changes.

More...

The More... menu displays the following features:

Voice Cmds Displays your list of voice commands.

Hot Keys Displays your list of HotKeys.

Services Quick access to carrier services.

Call Timers Maintains a running total of calling time 
for the current month and previous month. 
Call timers begin counting air time as 
soon as you initiate or receive a call. This 
feature is used to approximate your call 
usage. It is for estimation purposes and 
cannot be used for billing purposes.
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Clock Setting Used to set the time, date, etc. when not 
within carrier service range. The carrier 
signal will automatically correct the clock 
settings when within signal range.

Info Provides phone model, available memory, 
software release, record counts, and other 
information.

Refer to “Using More...” on page 89 for procedural information.

Voice Commands

This feature allows you to view a list of your voice 
commands - a maximum of 30. Voice Commands allow 
you to program and quickly access information and 
execute applications. You can create voice commands for 
use in your automobile with a Hands-Free Kit (HFK) or 
normal hand-held use. 

Due to acoustic variances, voice commands created 
using your Hands-Free Kit cannot be used for hand-
held use and vice versa. 

Once a Voice Command is programmed, you can access 
the information or application by simply saying the word. 

Refer to “Creating a Voice Command” on page 89 and “Using a Voice Command” 
on page 90 for information on how to create and use voice commands. For more 
information on using the Hands-Free Kit, refer to “Hands-Free Kit For Your 
Automobile” on page 106.
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HotKeys

This feature allows you to view the list of HotKeys. 
HotKeys allow you to program and quickly access 
information and execute applications. Once a HotKey is 
programmed, you can access the information or 
application with the push of a key pad number (2-9 and 
0). Refer to “Creating a HotKey” on page 91 and “Using 
a HotKey” on page 91 for procedural information on how 
to create and use HotKeys.

Services

The Services application has the following options:

Customer Care Initiate a call to your carrier 
service provider regarding your 
phone service.

Roadside Rescue Initiate a call to your carrier 
service provider requesting 
roadside assistance.

Prepaid Calling Initiate a call to your carrier 
service provider regarding prepaid 
calling options.

Block My CallerID Initiates a call to your carrier service provider to block your 
phone number ID to all numbers that you call. Providing the 
number you are calling has a device or phone capable of 
displaying Caller ID, it displays restricted or unavailable 
instead of displaying your phone number.

Call Wait Off Allows you to turn off the capability to receive a call while 
you are currently on a call. This feature initiates a call to your 
service provider and is available on a “per call basis.”

Call Forward Off Allows you to turn off forwarding a call to a different phone 
number. This feature initiates a call to your service provider 
and deactivates the Call Forward feature.
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Call Forward On Allows you to forward calls to a different phone number. This 
feature initiates a call to your service provider and is available 
on a “per call basis.”

Press Send or Select (changes based on specific selection).

Call Timers

Call timers allow you to keep a running count of the time 
you spend making calls. 
This Month Time you spent on the phone since the 

Start Day. Although it cannot be used 
for billing purposes, this helps you to 
maintain an approximate usage of 
calling time.

Last Month Time you spent on the phone from last 
month’s Start Day.

Start Day Specifies the day of the month you want 
to begin timing your calls. You may 
want to set the start date to match your 
billing start date.

Current Running total time since last reset.
Clear Current Resets timer to zero (0:00).
Timer

Clock Setting

This feature is used only when there is no carrier service signal to your phone. It 
allows you to set the clock on your phone. If there is a signal, it will display the 
following message: Local time has already been acquired.
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Info

The Info feature displays information about your NeoPoint phone. The following two 
screens display this type of information, including phone and personal information 
manager (PIM) information:

From the PIM Info screen, press MORE (Soft Key 2) and the Versions screen will 
appear. When calling NeoPoint Customer Service/Support, have this information 
readily available.
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Chapter 3: Syncing Your
NeoPoint Phone

Overview

This chapter discusses how to sync your NeoPoint phone and your PC. It assumes 
you have already installed and configured the sync software. For instructions on 
installing and configuring your sync software, refer to the sync documentation that 
came with your phone kit.

Why sync your phone? The benefit of syncing is to make it convenient for you to 
transfer data between the NeoPoint phone and your personal information 
management (PIM) program. For example: when you enter all of your friends and 
business associates - referred to as contacts - information into your PC and then 
transfer or sync the data to your NeoPoint phone, you have:

• All of the information with you wherever you go (with your phone)

• Saved yourself the task of entering the data twice (on the PC and phone)

• Created a data backup (if you lose the data on your PC, you have a data back - up 
on your phone.

The same is true for your personal schedule information. The NeoPoint phone can 
display your next meeting/appointment, notify you in advance of your meeting/
appointment, etc.

1
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Syncing the Phone with Your PC

IMPORTANT!Close all PIM programs before syncing data. 

If the “Monitoring” phone icon  is not displayed on your MS-Windows Task 
Bar, double-click on the SoftSync shortcut icon  on your Desktop to initiate PC 
monitoring of your phone. Once activated, the “Monitoring” icon will be displayed 
on your Task Bar.

1. Power ON your NeoPoint phone.

2. Plug one end of the SoftSync cable into your NeoPoint phone.
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3. Plug the other end of the SoftSync cable into one of the 9-pin serial ports on your 
PC.

4. On your phone, press the Main/Menu button.

9-pin Serial Port
Your PC
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5. Scroll to the Sync application and press SELECT (Soft Key 1).

6. Press START (Soft Key 1) to begin data transfer between your phone and PC.

When the transfer is complete, the phone will display “Sync Completed.”

7. Press DONE (Soft Key 2) to return to the Menu screen.

8.
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Chapter 4: Using Your
NeoPoint Phone

Overview

The purpose of this chapter is to provide you with easy-to-follow steps for NeoPoint 
features and commands.

Making a Call...

There are several different methods for placing a call. You can place a call from the 
Main, Call History, Contacts, Text Messages, To Do, and Schedule screens.

From the Main Screen

1. Open the flip.

2. Dial the telephone number.

3. Press the SEND key.

4-Digit Dialing

The NeoPoint phone allows you to dial the last four digits of a phone number, given 
the number has been programmed into Contacts. For more information programming 
a contact, refer to “Using Contacts” on page 74.

1
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Answering a Call

When the phone rings, the phone will indicate that you have an incoming call by:

• Ringing

• Flashing the call indicator light

• Displaying an onscreen message “Incoming call from 234-456-7890 (the caller’s 
number or restricted if blocked)

You have the following options:

• Press the SEND key (while the flip is open) or Soft Key 1 while indicating Talk 
function

or

• Open the flip (when Active Flip is On)
or

• Press any key (except for the power and volume keys and when Anykey Answer is 
On) to answer the call

or

• Press Ignore (Soft Key 2) to send the call to voicemail

NOTE:The Anykey Answer and Active Flip factory default settings are 
On. To disable these features, refer to “Enabling/Disabling Anykey 
Answer” on page 86 and “Enabling/Disabling Active Flip” on page 86. 
By disable these features, the first two methods of answering a call will 
not work.

Ending a Call

After concluding your conversation, you can end your call by performing one of the 
following three options:

• Press the END key

or

• Press End (Soft Key 1) to terminate your call

or

• Close the flip of your phone

NOTE: If you have set the Active Flip feature to Off, closing the flip will 
not terminate your call.
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Redialing

1. From the Main screen, with the flip open, press the SEND key. This takes you to 
the Call History screen, displays the Call History list, and selects the last call 
you made on your phone.

or

2. From the Main screen, with the flip closed, you can press the Soft Key 1 twice.

3. Press the SEND key again to dial and connect the call. 

Making a Three-Way Call

Three-way calling allows you to talk with two people at the same time.

1. Dial the first number and press the SEND key.

2. After the first call connects, dial the second number.

3. Press the SEND key. (The first number you called is now placed on hold.)

4. Once the second call is connected, press the SEND key again. The conference 
call is now in progress.

NOTE:If you press the END key or close the flip with Active Flip On 
to terminate a conference call, the connection between the other two 
parties will terminate. However, if one of the two parties terminates a 
call, it will not affect the connection between you and the remaining 
party.

Call Waiting

Call waiting is a feature offered by your carrier service provider. Call waiting is when 
you are on a current call and you receive an incoming call. On the NeoPoint phone, 
you will hear a click through the ear piece indicating that you are receiving another 
call. To answer this second call or call waiting, use the following procedure:

1. Press SEND to answer the second call. The phone connects to the second party, 
placing the first party on hold.

2. Press SEND again to switch to the first call.

3. Press END when finished with the call.
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Disabling Call Waiting

Call waiting can be disabled on a per-call basis from your carrier service provider. 
This feature allows you to have a conversation with out interruption from other calls. 
To disable call waiting, use the following procedure:

1. Select More from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Services.

4. Press Select (Soft Key 1).

5. Select Call Wait Off.

6. Press Select (Soft Key 1).

7. Enter the 10-digit number to be dialed.

8. Press OK (Soft Key 1).

Using Quick Mode

Quick Mode is designed to allow you quick access to several operations:

• Power Off Power phone off

• Enable/Disable Keyguard Select or Cancel

• Lock the Phone Select or Cancel

• Mode Normal, Silent, or PDA

• Incoming Voice, Data In, or Fax In

Enabling Keyguard

1. Press the POWER key to access the Quick Mode screen.

2. Scroll to Enable Keyguard.

3. Press Select (Soft Key 1).

Answering a Call With Keyguard Active

There are several methods to answer a call when Keyguard is On. Use any of the 
following methods: 

• Press Send (Soft Key 1).

• Open the flip (if the Active Flip feature is active).
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Disabling Keyguard

1. Press the POWER ON/OFF key to access the Quick Mode screen.

2. Scroll to Disable Keyguard.

3. Press Select (Soft Key 1).

Locking the Phone

NOTE:Ensure that you know the correct lock code prior to locking the 
phone. Default lock code is last 4-digits of your phone number.

1. Press the POWER ON/OFF key to access the Quick Mode screen.

2. Select Lock the Phone. 

3. Press Select (Soft Key 1). A pop-up window appears and displays “Lock 
phone?”

4. Press Yes (Soft Key 1).

Once the phone is locked, a lock indicator will appear on the Main screen. The 
phone is restricted from making calls until the lock code/password is entered. 
However, you can still receive phone calls while the phone is locked.

NOTE: You may still call a number on your Emergency List even if the 
phone is locked. To create an Emergency List, refer to “Creating and 
Editing an Emergency List” on page 83.

The phone may also be locked by pressing and holding the END key for 5 
seconds.

Unlocking the Phone

1. Press Unlock (Soft Key 1) from the Main screen.

2. Enter the code to unlock the handset.

3. Press OK (Soft Key 1).
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Changing the Phone Mode

1. From the Quick Mode screen, use the Navigator key to scroll to Mode.

2. Use the Navigator key to scroll to Normal, PDA or Silent mode.

Normal Sends and receives calls - normal phone operation

Silent Turns off ringer, clicks, and other sound generation. Can still 
receive and place calls.

PDA Allows you to use the personal digital assistant (PDA)/personal 
information manager (PIM) functions of your NeoPoint phone 
without sending or receiving calls

3. Press Select (Soft Key 1).

Changing the Incoming Mode

This mode is used to receive different types of calls: voice, data, and fax. For sending 
data and fax transmission, you do not need to change the mode, i.e., use voice mode. 
The Incoming Mode has the following three options:

Voice Receives calls - normal phone operation

Data In Sets the phone to function as a wireless modem, receive data 
transmission, and pass to your computer.

Fax In Sets phone to function as a wireless modem, receive fax 
transmission, and pass to the attached computer.

For specific instructions on how to setup your NeoPoint phone to act as a wireless 
modem, send, and receive data and fax calls, refer to “Appendix A: Receiving and 
Sending Fax and Data Calls” on page 115.

The following sections detail how to configure your NeoPoint phone to receive data 
and fax transmissions.

Changing the Incoming Mode to Receive Data

This feature allows your NeoPoint to function like a modem and pass information to 
your PC. To use this feature, you must connect your NeoPoint phone to your PC via 
your SoftSync cable.

1. Connect your SoftSync cable to a 9-pin serial port on your PC.

2. Insert the other end of the SoftSync cable into your NeoPoint phone.

3. Ensure that your NeoPoint is powered On.
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4. Press the Power On/Off key once to display the Quick Mode screen.

5. From the Quick Mode screen, use the Navigator key to scroll to Incoming.

6. Use the Navigator key to select Data In.

Your phone is now set to receive incoming data calls.

Changing the Incoming Mode to Receive a Fax

This feature allows your NeoPoint to function like a fax modem and pass wireless fax 
information to your PC. To use this feature, you must connect your NeoPoint phone 
to your PC via your SoftSync cable.

1. Connect your SoftSync cable to a 9-pin serial port on your PC.

2. Insert the other end of the SoftSync cable into your NeoPoint phone.

3. Ensure that your NeoPoint is powered on.

4. Press the Power key once to display the Quick Mode screen.

5. From the Quick Mode screen, use the Navigator key to scroll to Incoming.

6. Use the Navigator key to select Fax In.

Your phone is now set to receive incoming fax calls.

Changing the Incoming Mode to Normal Voice Calls

1. From the Quick Mode screen, use the Navigator key to scroll to Incoming.

2. Use the Navigator key to select Voice.

3. Press Select (Soft Key 1).

Your phone is now set to receive voice calls.

Using Inbox

Retrieving Voicemail Messages

1. Scroll to the Inbox from the Menu screen.

2. Press Select (Soft Key 1).

3. Select New Voicemail (“No Voicemail” is displayed if you do not have any 
voicemail).

4. Press Listen (Soft Key 1).

Accessing voicemail is carrier-dependent. Refer to your carrier for more information.
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Deleting Voicemail Listings

Voicemail function is controlled by the carrier. Each voicemail message is stored at 
the carrier server and individually accessed through a phone call to the mailbox at the 
server. 

1. Select Inbox from the Menu screen.

2. The cursor will default to Voicemail. Press Select (Soft Key 1).

3. Press View (Soft Key 2). This displays the Voicemail List.

4. Press Delete (Soft Key 2) and a pop-up window displays “Delete all 
voicemails?”

5. Press Yes to delete all voicemail listings.

NOTE:Deleting a voicemail message from your Inbox does not delete 
it from your carrier service mailbox, and vice versa.

Viewing Text Messages

1. Scroll to the Inbox from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Text from the Inbox screen.

4. Press View (Soft Key 1).

5. Choose the desired message.

6. Press Detail (Soft Key 1).

The Text Messages screen displays the message.
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Locking Text Messages

1. Scroll to the Inbox from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Text from the Inbox screen.

4. Press View (Soft Key 1).

5. Scroll to the desired message to be opened.

6. Press Detail (Soft Key 1).

7. Press Options (Soft Key 1).

8. Select Lock (Soft Key 1)

The text message is now locked and cannot be overwritten or deleted. The Lock-In 
Option screen now changes to Unlock, ready for your disposal.

Making a Call From a Text Message

If a text message contains a phone number, you can make a call from the Text 
Messages screen.

1. Scroll to the Inbox from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Text from the Inbox screen.

4. Press View (Soft Key 1).

5. Scroll to the desired message using the Navigator key.

6. Press Detail (Soft Key 1). The message is displayed.

7. Press Options (Soft Key 1).

8. Select Find numbers.

9. Press OK (Soft Key 1).

10. Use the Navigator key to select the desired number.

11. Press Send (Soft Key 1).
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Saving a Number From a Text Message

If a text message contains a phone number, you can save the number to your Contacts 
list by performing the following procedure:

1. Select Inbox from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Text from the Inbox screen.

4. Press View (Soft Key 1).

5. Scroll to the desired message using the Navigator key.

6. Press Detail (Soft Key 1). The message is displayed.

7. Press Options (Soft Key 1).

8. Select Find numbers.

9. Press OK (Soft Key 1).

10. Use the Navigator key to select the desired number.

11. Press Save (Soft Key 2).

12. Select the phone number type: home, work, mobile, other).

13. Press OK and the phone will automatically go to the Contact feature. From 
there, you can enter the contact information.

Deleting Text Messages

1. Select Inbox from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Text from the Inbox screen.

4. Press Select (Soft Key 1).

5. Press View (Soft Key 1).

6. Scroll down to the message you want to delete.

7. Press Options (Soft Key 2).

8. Select Delete.

9. Press OK (Soft Key 1). A pop-up window appears and displays “Delete this text 
message?”

10. Press Yes (Soft Key 1) to confirm.
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Using Call History

Making a Call From Call History

1. Select Call History from the Menu screen (or by pressing a soft key from the 
Main screen if the soft key is set up as “Calls”).

2. Press Select (Soft Key 1).

3. Scroll to the desired number using the Navigator key.

4. Press the SEND key.

or

Press Send (Soft Key 1).

or

Press Options (Soft Key 2), select Detail, and press OK (Soft Key 1) and press 
Send (Soft Key 1).

Refer to “Saving a Number From Call History to Contacts” on page 73 for more 
information on how to save a number from Call History.

Saving a Number From Call History to Contacts

1. From the Call History screen, select the number you want to save.

2. Press Options (Soft Key 2).

3. Select Save number.

4. Press OK (Soft Key 1).

5. The Save number pop-up window will appear. From this window, select the 
location where you want the number to be saved (Home, Work, Mobile, or 
Other).

6. Press OK (Soft Key 1). The New Contact screen will appear. For more 
information, refer to “Creating a New Contact Entry” on page 74.

Deleting a Number

1. Select Call History from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to the desired number using the Navigator key.
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4. Press Options (Soft Key 2).

5. Select Delete. A pop-up window displays “Delete the call details?” requesting 
you confirm your decision.

6. Press OK (Soft Key 1).

7. Press Yes (Soft Key 1).

Using Contacts

Creating a New Contact Entry

1. Select Contacts from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Add New Contact.

4. Press New (Soft Key 1).

5. Enter the contact information, i.e., names, numbers, etc.

6. Press Done (Soft Key 1) when finished.

Making a Call From Contacts

1. Select Contacts from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the desired contact.

If there is a usable phone number in the entry, the phone icon  will be 
displayed in the upper right corner of the screen.

4. Press the SEND key or press Send (Soft Key 1).

Editing an Entry in Contacts

1. Select Contacts from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the entry to be edited.

4. Press Detail (Soft Key 1).

5. Select Edit (Soft Key 1).

6. Use the Navigator key to go to the fields you want to change.



Chapter 4: Using Your NeoPoint Phone

NeoPoint™ 1600 User’s Guide 75

7. Use the CLR key to erase a character or press and hold CLR to delete the entire 
field.

8. After you have finished entering the information, press Done (Soft Key1).

Deleting an Entry in Contacts

1. Select Contacts from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the entry you want to delete.

4. Press Detail (Soft Key 1).

5. Press Delete (Soft Key 2). A pop-up window appears and displays “Delete 
record?”

6. Press Yes (Soft Key 1) to confirm.

Looking Up a Name

1. Select Contacts from the Menu screen.

2. Press Select (Soft Key 1).

3. Enter the person's last name using the key pad and the phone will attempt to 
locate the contact name.

For example, if you want to lookup Smith, type 76484. If there is more than one 
entry with the last name Smith, use the Navigator key to scroll to the next 
contact.

Using Schedule

Creating a Schedule Entry

1. Select Schedule from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select a date or press Month (Soft Key 2) and select a 
date from the monthly calendar. 

4. Press New (Soft Key 1).

5. Select Press New to Add New Event.

6. Use the Navigator key to set the Time, Length, Repeat, and Alarm options. 



76 NeoPoint™ 1600 User’s Guide

4

7. Use the Key pad to enter the Subject and Note information.

8. Press Done (Soft Key 1) when finished.

Making a Call in Schedule

1. Select Schedule from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the date of the entry or press Month (Soft Key 2) 
and select a date from the monthly calendar. If there are multiple entries for that 
day, select the desired scheduled event.

If there is a usable phone number in the entry, the phone icon  will be 
displayed in the upper right corner of the screen.

4. Press Send (Soft Key 1).

Editing an Event in Schedule

1. Select Schedule from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the date of the entry or press Month (Soft Key 2) 
and select a date from the monthly calendar. 

4. Press Detail (Soft Key 1).

5. Use the Navigator key to select the entry you want to edit.

6. Press Edit (Soft Key 1) and make the appropriate changes.

7. Press Done (Soft Key 1).

Deleting an Event in Schedule

1. Select Schedule from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the date of the entry or press Month (Soft Key 2) 
and select a date from the monthly calendar. 

4. Press Detail (Soft Key 1).

5. Use the Navigator key to select the entry you want to delete.

6. Press Edit (Soft Key 1).
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7. Press Delete (Soft Key 2). A pop-up window appears and displays “Delete 
record?”

8. Press Yes (Soft Key 1) to confirm.

Using To Do

Creating a To Do Entry

1. Select To Do from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select Add New Item.

4. Press New (Soft Key 1).

5. Use the Navigator key to set the Priority and Status.

6. Use the Key Pad to enter the Subject and Note.

7. Press Done (Soft Key 1). 

Making a Call From To Do

1. Select To Do from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select a To Do item with a phone number.

If there is a usable phone number in the entry, the phone icon  will be 
displayed in the upper right corner of the screen.

4. Press the SEND key.

Editing a To Do Entry

1. Select To Do from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the entry to be changed. Change the Status to 
Done if the task has been completed by pressing the Navigator key).

4. Press Edit (Soft Key 1) and make the appropriate changes.

5. Press Done (Soft Key 1).
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Deleting a To Do Entry

1. Select To Do from the Menu screen.

2. Press Select (Soft Key 1).

3. Use the Navigator key to select the entry to be deleted.

4. Press Edit (Soft Key 1).

5. Press Delete (Soft Key 2). A pop-up window appears and displays “Delete 
record?”

6. Press Yes (Soft Key 1) to confirm.

Using MiniBrowser

For specific information on MiniBrowser, refer to “Appendix B: Using the 
MiniBrowser” on page 131. For more information and documentation on 
MiniBrowser, refer to your carrier service provider or visit MiniBrowser on the web 
at: www.uplanet.com. 

Using Sync

Refer to “Chapter 3: Syncing Your NeoPoint Phone” on page 59 for detailed 
information on how to install the SoftSync software program and how to sync your 
data.

Using Preferences

Changing the Ringer Type

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Ringer Type.

4. Press Select (Soft Key 1).

5. Once you highlight a function (Calls, MiniBrowser, Message, Voicemail, 
Scheduler, or Roam Call), use the Navigator key to change to a different ring 
tone. 
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6. Once you select the type you like, press Done (Soft Key 1).

Changing the Volume of the Ringer, Ear Piece, or Key Pad

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Volume.

4. Press Select (Soft Key 1).

5. Once you highlight a function (Ringer, Ear Piece, or Key pad), use the 
Navigator key to change the volume level.

6. Press Done (Soft Key 1).

Key Beep

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Key Beep.

4. Press Select (Soft Key 1).

5. Choose the settings for the following: Key Tone, and DTMF Length.

6. Press Done (Soft Key 1).

Setting the Alerts

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Alerts.

4. Press Select (Soft Key 1).

5. Using the Navigator key, choose On or Off for the following: Roam Beep, 
Service Change, or MiniBrowser.

6. Press Done (Soft Key 1).

Deleting Your Phone Number from the Main Screen

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).
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3. Scroll to Main Screen.

4. Press Select (Soft Key 1).

5. Scroll to Phone Number and change to Off using the Navigator key.

6. Press Done (Soft Key 1).

Changing the Time Format

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Main Screen.

4. Press Select (Soft Key 1).

5. Scroll to Time Fmt and change to either 24 Hr or 12 Hr using the Navigator 
key.

6. Press Done (Soft Key 1).

Controlling the Next Event Display from the Main Screen

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Main Screen.

4. Press Select (Soft Key 1).

5. Scroll to Next Event and change to either Off or On using the Navigator key.

6. Press Done (Soft Key 1).
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Changing Backlight Settings

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Display.

4. Press Select (Soft Key 1).

5. Scroll to Backlight.

6. Set the length of time (5, 10, 15, 30 secs., On, or Off) using the Navigator key.

7. Press Done (Soft Key 1).

NOTE:Night Light settings override Backlight settings during the 
hours of 5 PM to 5 AM. and the flip must be open.

Changing the Display Contrast

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Display.

4. Press Select (Soft Key 1).

5. Scroll to Contrast.

6. Using the Navigator key, select the contrast setting using the scale of 0 (lightest) 
to 10 (darkest).

7. Press Done (Soft Key 1).
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Changing Night Light Settings

NOTE:Night Light settings override Backlight settings during the 
hours of 5 PM to 5 AM. In addition, the flip must be open to activate.

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Display.

4. Press Select (Soft Key 1).

5. Scroll to Night Light.

6. Select the length of time (15, 30 sec., 1 min., or Off) using the Navigator key.

7. Press Done (Soft Key 1).

Changing the Menu Screen to Display List or Icons

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Display.

4. Press Select (Soft Key 1).

5. Scroll to Menu Screen.

6. Use the Navigator key to select either List or Icons.

7. Press Done (Soft Key 1).

Setting Security Options

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Security.

4. Press Select (Soft Key 1).

5. You have 10 seconds to enter the Lock Code.

6. Press OK (Soft Key 1).

7. Choose the settings or programming for the following: Lock Code, Power-up 
Lock, Password, Emergency List, Defaults, and Database Reset.

8. Press Done (Soft Key 1).



Chapter 4: Using Your NeoPoint Phone

NeoPoint™ 1600 User’s Guide 83

Enabling/Disabling you Lock Code

1. From the Security screen and Lock Code option selected, press the Left/Right 
Navigator key to enable/disable the lock code.

2. When finished, press Done (Soft Key 1).

Changing Your Lock Code

1. From the Security screen and Lock Code option selected, press Edit 
(Soft Key 2).

A pop-up window will appear requesting you to enter the new lock code.

2. Enter the new lock code. It will prompt you to re-enter the new lock code.

3. When finished, press Done (Soft Key 1).

Creating and Editing an Emergency List

1. From the Security screen, scroll to Emergency List.

2. Press Edit (Soft Key 2).

3. Enter the emergency phone numbers.

4. Press Done (Soft Key 1).

NOTE:It is recommended that you include the number to your 
carrier service provider in your emergency list. This allows you to 
make calls to your provider even if your phone is locked, you cannot 
remember your password, are experiencing difficulties, etc.

Resetting the Phone to Factory Default Settings

NOTE:This feature will reset your phone to default settings. It is not 
recommended to use this option unless you are sure you want to 
reset your phone settings. Refer to “Default Settings” on page 84 to 
view the settings.

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Security.

4. Press Select (Soft Key 1).

5. Enter the Lock Code.

6. Press OK (Soft Key 1).

7. Scroll to Defaults.
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8. Press Reset (Soft Key 2). A pop-up window appears and displays “Set all of the 
user settings to the factory defaults?”

9. Press Yes (Soft Key 1) to confirm.

10. Press Done (Soft Key 1).

Default Settings

NOTE: Default Settings may vary depending on your carrier service. 
Refer to your release notes or your carrier for specific default 
variances.

Ringer Type:
Calls Basic
MiniBrowser Beep
Message Parrot
Voice Mail Slots
Scheduler Elise
Roam Call Jackpot

Volume:
Ringer 6 (Loudest)
Ear Piece 5
Key Pad High

Key Beep:
Key Tone Tones
DTMF Length Short

Alerts:
Roam Beep Off
Service Change Off
MiniBrowser On

Main Screen:
Phone Number Display On
Time Format 12 Hr
Next Event Off
Soft Key 1 Calls
Soft Key 2 Inbox
Navigator Up Schedule
Navigator Down Contacts/Address
Navigator Right To Do
Navigator Left MiniBrowser
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Display Settings:
Backlight 5 seconds
Contrast 5 out of 10
Night Light Off
Menu Screen List

Security:
Lock Code Enabled
Power-Up Lock No
Emergency List
Defaults
Database

General:
Active Flip On
Anykey Answer On
Sync Manual Mode
Power Save Off
Car AutoAnswer Off
Wakeup Alarm On
Internet Shield On

Banner:

NeoPoint 1000

Resetting the Database to Factory Defaults

This feature will erase your Contacts, Schedule, and To Do settings. 
It is not recommended to use this option unless you are absolutely 
sure you want to reset these settings.

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Security.

4. Press Select (Soft Key 1).

5. Enter the Lock Code.

6. Scroll to Database.

7. Press Reset (Soft Key 2). A pop-up window appears and displays “Set all of the 
user settings to the factory default settings?”

8. Press Yes (Soft Key 1) to confirm.

9. Press Done (Soft Key 1).
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Enabling/Disabling Active Flip

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to General.

4. Press Select (Soft Key 1).

5. Set Active Flip to On or Off by using the Navigator key.

6. Press Done (Soft Key 1).

Enabling/Disabling Anykey Answer

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to General.

4. Press Select (Soft Key 1).

5. Set Anykey Answer and set it to On or Off by using the Navigator key.

6. Press Done (Soft Key 1).

Setting Sync to Manual or Automatic

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to General.

4. Press Select (Soft Key 1).

5. Scroll to Sync and change the setting to Auto or Manual using the Navigator 
key.

6. Press Done (Soft Key 1).
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Enabling/Disabling Power Save

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to General.

4. Press Select (Soft Key 1).

5. Scroll to Power Save.

6. Set to On or Off.

7. Press Done (Soft Key 1).

Activating/Deactivating Car Auto Answer

This feature is used with the Hands-Free Kit for your automobile. To use this feature, 
install your Hands-Free Kit (refer to “Hands-Free Kit For Your Automobile” on page 
106). Once the installation is complete, perform the following procedure:

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to General.

4. Press Select (Soft Key 1).

5. Scroll to Car AutoAnswr using the Navigator key.

6. Choose On or Off using the Navigator key.

7. Press Done (Soft Key 1).

This feature will display the following message on the Main screen: 
“*Auto Answer*” when activated.
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Wakeup Alarm

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to General.

4. Press Select (Soft Key 1).

5. Using the Navigator key, scroll to Wakeup Alarm.

6. Choose On or Off using the Navigator key.

7. Press Done (Soft Key 1).

Internet Shield

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to General.

4. Press Select (Soft Key 1).

5. Scroll to Internet Shield using the Navigator key.

6. Choose On or Off using the Navigator key.

7. Press Done (Soft Key 1).

Changing the Banner

1. Scroll to Preferences from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Banner.

4. Press Select (Soft Key 1).

5. Using the CLR key, erase the old and enter the new message you would like to 
display on the Main screen.

6. Press Done (Soft Key 1).
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Using More...

Creating a Voice Command

Although the following example shows “how to make a phone call” using the Voice 
Command feature, you can set any application or function as a voice command.

1. Scroll to the application or function to be executed by the Voice command.
For this example, the selected application is Contacts.
scroll to Contacts from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to a desired record.

4. Press Detail (Soft Key 1).

5. Scroll to a number that you want the voice command to call.

6. Press and hold down the #SPACE key.

7. Scroll to Make Voice Cmd from the Mark screen.

8. Press OK (Soft Key 1).

9. At the prompt, speak the command word(s).

For best results, speak clearly and close to the speaker. 

10. The phone will repeat your voice command to you and request that you “Say the 
command again.” Repeat the command at the prompt. The phone will repeat the 
command again to you. If the command was successfully recorded, you will 
hear the phone say “You’ve successfully created a new command.”

Things to Remember When Creating a Voice Command

NOTE:· For best results, you should move to a quiet area with no 
background noise. If your voice is affected for some reason (e.g., an 
illness), wait until your voice returns to its normal tone before 
creating any voice commands. Hold the phone as you would making 
a phone call.

When creating a voice command, implement the following recommendations:

1. Speak in a normal, clear, and continuous manner.

2. Use the same tone and volume to create the voice command. 

3. Do not include any noticeable pauses between words.

4. For best results, voice commands should be distinct from each other.
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5. Your commands should last no longer than 3 seconds.

6. If your command consists of only of one word, ensure that the word contains 
more than one syllable.

View the List of Voice Commands

1. Scroll to More... from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Voice Commands.

4. Press Select (Soft Key 1).

The list of Voice Commands is displayed.

Using a Voice Command

NOTE:When speaking the voice command, you should hold the 
phone as you normally do while speaking on the phone. If there is 
too much background noise then you should either move to a quieter 
area.

1. Press and hold down one of the VOLUME keys.

2. At the prompt, say the voice command. The command will be repeated back to 
you and the function will be carried out.

If you forget what your voice commands, go to the More... menu, select Voice 
Cmds. A list of your voice commands are displayed. Scroll to the voice 
command you want to hear and press Play.

Deleting a Voice Command

1. Scroll to More... from the Menu screen.

2. Press Select (Soft Key 1).

3. Select Voice Cmds.

4. Press Select (Soft Key 1).

5. Select the Voice Command to be deleted.

6. Press Erase (Soft Key 2).

7. Press OK (Soft Key 1).

8. Press Yes (Soft Key 1) to confirm your deletion decision.
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Creating a HotKey

The HotKey command is similar to Voice Command - it allows you to quickly access 
applications, functions, etc. by pressing and holding one of the numeric keys (0, 2-9).

1. Scroll to the application or function to be executed by the HotKey command.

2. Press and hold down the #SPACE key.

3. Scroll to the Make HotKey.

4. Press OK (Soft Key 1).

5. Select an empty number button in the Make HotKey screen.

6. Press Mark (Soft Key 1).

Viewing the List of HotKeys

1. Scroll to the More... screen from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to HotKeys.

4. Press Select (Soft Key 1).

The list of HotKeys is displayed.

Using a HotKey

Press and hold down the appropriate HotKey (e.g., the 3 button) for approximately 2 
seconds. The function will then be executed.

Deleting a HotKey

1. Scroll to More... from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to HotKeys.

4. Press Select (Soft Key 1).

5. Scroll to the HotKey to be deleted.

6. Press Delete (Soft Key 1).

7. Press Yes (Soft Key 1) to confirm.
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Using Block My CallerID

NOTE:This function is executed on a per call basis. Prepare to enter 
the 10-digit phone number that you intend to call at the prompt.

1. Scroll to More from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Services.

4. Press Select (Soft Key 1).

5. Scroll to Block My CallerID.

6. Press Select (Soft Key 1). A pop-up window is displayed.

7. Enter the 10-digit phone number to be dialed.

8. Press OK (Soft Key 1). The call is then placed with your CallerID blocked.

9. Press End (Soft Key 1) to terminate the call.

Forwarding a Call

1. Scroll to More... from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Services.

4. Press Select (Soft Key 1).

5. Use the Navigator key to select Call Forward On.

6. Press Select (Soft Key 1)

7. Enter the 10-digit number where you want calls to be forwarded.

8. Press OK (Soft Key 1) when finished.

Disabling Call Forwarding

1. Scroll to More... from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Services.

4. Press Select (Soft Key 1).

5. Scroll to Call Forward Off.

6. Press Send (Soft Key 1) and the call will connect to your service carrier.
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7. Once the call has connected, it will last for approximately 4 seconds and then 
terminate the call. A pop-up window appears stating that Call Forward has been 
turned off. Press OK to clear the message from the screen or wait momentarily 
and it will automatically disappear.

Setting Call Timers

1. Scroll to More... from the Menu screen.

2. Press Select (Soft Key 1).

3. Scroll to Call Timers.

4. Press Select (Soft Key 1).

There are two option for setting Call Timers: Start Day and Clear Current Timer. 

• To set the Start Day, use the Navigator key to select the day of the month you 
want the call timer to begin. Typically, this day of the month should coincide 
with your carrier service billing date.

• To clear the Current Timer, press Reset (Soft Key 2).

5. When you have completed your changes to Call Timers, press 
Done (Soft Key 1).

If you want to exit Call Timers without saving changes, press the BACK key. A 
pop-up window appears stating “Save Changes?” Press No (Soft Key 2).
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Chapter 5: NeoPoint Care
and Troubleshooting

Overview

This chapter discusses the following topics:

• NeoPoint Care

• Cleaning Instructions

• Basic Troubleshooting Techniques

NeoPoint Care

• Keep your phone free from dirt, dust, and liquid.

• Keep your phone dry - humidity and liquids may cause your phone to fail and will 
corrode the internal circuits.

• Keep your phone from getting too hot - high temperatures may damage the 
batteries, shorten the life of electronic components, and warp or melt certain 
plastics.

• Do not attempt to open or access the internal components of your phone. If your 
phone is not functioning properly, take it to a qualified NeoPoint service center.

• Do not drop, shake, or handle your phone in a rough manner - it may damage 
internal components or the LCD screen.

Cleaning Instructions

There are two parts to the cleaning instructions:

• Prior to Cleaning

• Cleaning Your NeoPoint

1
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Prior to Cleaning

Always power off the NeoPoint prior to cleaning.

Avoid using harsh chemicals, strong detergents, and petroleum-based solvent 
cleaners to clean your phone. (Some household cleaners may contain chemicals that 
may damage your phone.)

Do not apply cleaning liquids directly to your phone.

Cleaning Your NeoPoint

Clean the external surfaces of your NeoPoint phone using a mild soap and water with 
a clean, soft towel.

Use a paper towel to dry any remaining moisture.

Basic Troubleshooting Techniques

The following table describes possible problems:

Table 5-1 Basic Troubleshooting Techniques

Problem Action

Keys/Keypad Problems

Keypad appears to be 
locked

• Ensure that the phone is not locked. If the 
phone is locked, Unlock (Soft Key 1) will 
be displayed. Unlock the phone. To 
unlock the phone, refer to “Unlocking the 
Phone” on page 67.

• Remove and reinstall the battery. Check 
to see if the keypad is now unlocked.

Key is stuck/repeating key • Inspect key and see if it is stuck/
misaligned under keypad housing. If so, 
push key slightly toward opposite 
direction to free key. If the problem 
persists, try cleaning the phone. Refer to 
“Cleaning Instructions” on page 95.
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Flip Lever Problems

Phone fails to respond to 
flip (answer or terminate a 
call)

• Ensure Active Flip is On. Refer to 
“Enabling/Disabling Active Flip” on page 
86.

• Check flip button and ensure it is not 
dirty, impeded, stuck, or broken. 

• If dirty or stuck, clean with a clean, dry 
cotton swab.

• If impeded, remove obstruction and 
recheck.

• If flip button is broken, take phone to an 
authorized NeoPoint service center.

Power/Battery Problems

Phone will not power ON • Check battery and phone-to-battery 
contacts.

• Ensure battery is charged and properly 
inserted.

Difficult to connect to:

• Battery

• NeoPoint charger

• Hands-free Kit

• Vehicle/Power 
Adapter

• Docking Station
Charging/connection light 
will not illuminate

Prior to performing the following steps, 
ensure that ALL power/battery is 
disconnected/removed.

• Check connections. If contacts are dirty, 
clean with a clean, dry cotton swab or an 
eraser, replace/connect power/battery, 
and recheck.

• Check the plug connection tabs/ears. If 
broken, take phone to an authorized 
NeoPoint service center.

Table 5-1 Basic Troubleshooting Techniques (Continued)

Problem Action
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Reception Problems

Poor reception • Ensure antenna is fully extended and not 
broken.

• Check signal strength and battery power 
level. If indoors, move closer to a 
window.

LCD Problems

LCD transparent or too 
dim

Go to Preferences/Display/Contrast, check 
the LCD contrast setting; increase contrast 
setting, if required. Refer to “Changing the 
Display Contrast” on page 81.

LCD cracked or broken Take phone to an authorized NeoPoint 
service center.

Audio Problems

Cannot hear ringer • Ensure Mode is set to Normal (not on 
Silent or PDA modes). Refer to 
“Changing the Phone Mode” on page 68.

• Check ringer settings in Preferences/
Volume/Ringer. If ringer setting is OFF, 
change to a higher setting. Refer to 
“Changing the Volume of the Ringer, Ear 
Piece, or Key Pad” on page 79.

Table 5-1 Basic Troubleshooting Techniques (Continued)

Problem Action
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Cannot hear through ear 
piece

• Check Incoming Mode is set to Voice (not 
Data In or Fax In). Refer to “Changing 
the Incoming Mode” on page 68.

• Check ear piece settings in Preferences/
Volume/Ear Piece. Refer to “Changing 
the Volume of the Ringer, Ear Piece, or 
Key Pad” on page 79.

• If Volume is set correctly, check if ear 
hole is clogged. If clogged, clean ear hole 
with a cotton swab.

Others cannot hear you Check if voice hole is clogged. If clogged, 
clean voice hole with a cotton swab.

Table 5-1 Basic Troubleshooting Techniques (Continued)

Problem Action
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Chapter 6: Accessories

List of NeoPoint Accessories

The NeoPoint 1000 has several accessories you can purchase to maximize your 
usage. These accessories include:

• SoftSync Station

• Travel Charger

• Desktop Holder

• Vehicle Power Adapter

• Hands-Free Kit

• Ear Set

• SoftSync Cable

• SoftSync CD

• Leather Case

• Handstrap

• Slim Battery

• Extended Battery
Accessory

Model Number

1
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SoftSync Station

Model Number: NPSS1000

Provides dual-charging for your phone and spare battery. In addition, also provides 
syncing options for the NeoPoint 1000.

Travel Charger

Model Number: NP1-TC

Plugs directly into the phone and charges the phone. Also plugs into the Desktop 
Holder and changes the phone.
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Desktop Holder

Model Number: NPDH1000

Holds the phone upright and charges the phone when connected to the Travel 
Charger.

Vehicle Power Adapter

Model Number: NPVA1000

Charges the phone while connected to your automobile cigarette lighter/power 
adapter.
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Hands-Free Kit

Model Number: NPHFF1000

Allows you to make and receive calls in your automobile using a microphone and 
speaker set.

Ear Set

Model Number: NPES1002

Provides privacy when listening to calls and built-in microphone allows you to talk 
without holding the phone close to your mouth to converse.
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SoftSync Cable

Model Number: NPSC1000

Connects your NeoPoint 1000 to your PC.

SoftSync or SoftSync Plus CDs

SoftSync Model Number: NPCD1000

SoftSync Plus Model Number: NPCDP1000

Contains PC software required to “sync” your NeoPoint phone to your PC.
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Leather Case or Pouch

Pouch Model Number: NPLP1000

Leather Case Model Number: NPLC1002

Two different ways to conveniently carry your NeoPoint phone. (Leather case shown 
in photo.)

Handstrap

Model Number: NPHS1002

Allows you to carry your NeoPoint and still have your hands free.
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Slim Battery

Champagne Model Number: NPSBC1000

Slate Model Number: NPSBS1000

Allows you to have a slim, lightweight phone. Comes in two colors: champagne and 
slate.

Extended Battery

Champagne Model Number: NPEBC1000

Slate Model Number: NPEBS1000

Lasts longer between charges. Comes in two colors: champagne and slate.
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Chapter 7: Did You Know...

This chapter is designed to help maximize using your NeoPoint phone. The following 
list of NeoPoint features may help to improve your knowledge and understanding of 
your NeoPoint phone and how to make it your new point of communication.

Did you know...  you can send a call to voicemail instead of answering the call?

There are two methods for sending calls to voicemail: Screening calls and 
redirecting all calls.

Screening calls allows you to view the incoming number and choose whether 
you want to answer the call or ignore the call. If you select Ignore (Soft Key 2), 
the call is routed to your voicemail. Refer to “Answering a Call” on page 64 for 
more information.

Redirecting all calls allows you to redirect or forward all of your calls to your 
voicemail.

Did you know...  you can answer your phone without opening the flip? 

By setting the phone to “Answer Any Key,” you can press any key, e.g., 
Navigator, Soft key 1, Menu, or Back keys to answer the phone. Refer to 
“Enabling/Disabling Anykey Answer” on page 86 for more information.

Did you know...  you can prevent your phone from ringing while in a meeting, etc., 
without powering off your phone?

You can set your phone to “Silent” mode and no audible sounds will be heard. 
However, your indicator light at the top of your phone will flash and the display 
screen will display that you have an incoming call. Refer to “Changing the Phone 
Mode” on page 68 for more information.

1
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Did you know...  your NeoPoint phone notifies you when you have a new voicemail, 
e-mail or text message?

When you have a new message, your NeoPoint phone will ring, display an 
onscreen message stating that you have a new voicemail/e-mail/text message, and 
display a small icon at the top of the main screen. There are three icons for 
incoming messages:

Voicemail

E-mail

Text Message

Simply select Inbox and select the message you want to retrieve. Refer to “Using 
Inbox” on page 69 for more information.

Did you know...  your NeoPoint phone can tell you who is calling?

Once you have created a contact in your NeoPoint phone, every time that person 
calls you, their name and number will be displayed. Refer to “Using Contacts” on 
page 74 for more information.

Did you know...  you can program your NeoPoint phone to make a call by saying 
their name?

Your NeoPoint phone allows you to create a Voice Command that can place a call 
to whomever you choose. After creating your voice command, the command is 
stored in memory and can be used whenever you want to place a call. Refer to 
“Creating a Voice Command” on page 89 and “Using a Voice Command” on page 
90 for more information.

Did you know...  you can program your NeoPoint phone to make a call by pushing a 
button?

Your NeoPoint phone allows you to create a HotKey that can place a call to 
whomever you choose. After creating your HotKey, the command is stored in 
memory and can be used whenever you want to place a call. Refer to “Creating a 
HotKey” on page 91 and “Using a HotKey” on page 91 for more information.
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Did you know...  you can lock your NeoPoint phone so that no one can use your 
phone (except to call numbers on your Emergency List)?

By using the Locking the Phone feature in Quick Mode, you can lock the phone so 
that no unauthorized use of your phone is allowed. This prevents anyone from 
making calls, accessing information on your phone, including contacts, 
appointments, etc., except to place outgoing calls to numbers on your 
Emergency List. Refer to “Locking the Phone” on page 67 for more information.

Creating an Emergency List allows anyone to place a call to a number on your list 
when your phone is locked. Your Emergency List can have up to four numbers. 
These numbers can include: 911, police, your home, etc. Refer to “Creating and 
Editing an Emergency List” on page 83 for more information.

Did you know...  you can set your NeoPoint phone to not send or receive signals?

Your NeoPoint phone has a mode that allows it to function solely as a personal 
digital assistant (PDA). PDA mode blocks the phone from making or receiving 
any type of signal and forwards all calls to voicemail. This allows you to work on 
your contacts, schedule and notes in areas where cellular calls are not permitted. 
For more information on setting your NeoPoint phone to PDA Mode, refer to 
“Changing the Phone Mode” on page 68.

Did you know...  your NeoPoint phone can spell words for you?

Your NeoPoint phone incorporates Tegic’s T9 text input mode which allows you 
to minimize typing on the key pad. As you type in a word, the phone starts to give 
any combination of key words. You can press the next key (or the zero button) to 
show you the next possible word. Tegic is used to facilitate the storing of contact 
numbers, notes etc. For more information on T9, refer to “T9 Mode” on page 32.

Did you know...  you can set your NeoPoint phone to guard against accidentally 
pressing keys while in your purse or pocket?

Your NeoPoint phone incorporates a feature call Keyguard. Keyguard is different 
than locking your phone... it prevents your phone from accidentally pressing 
unprotected keys, but is deactivated as soon as you open your flip. For more 
information on setting Keyguard, refer to “Enabling Keyguard” on page 66.
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Did you know... you can store up to 1000 friends, family, and business names, each 
with 17 lines of information in your NeoPoint?

Your NeoPoint phone has a feature called Contacts. Each contact record allows 
you to include the first and last names, title, company, five different phone 
numbers, e-mail address and web site, address, and finally - additional notes. For 
more information on creating a contact, refer to “Creating a New Contact Entry” 
on page 74.

Did you know... you can update information in your NeoPoint or MS-Outlook 
without retyping the same information again just by connecting your NeoPoint to 
your PC?

Once you have installed the SoftSync program, connected your SoftSync cable to 
your PC, you can set your NeoPoint phone to automatically update every time you 
connect your NeoPoint to the cable. If you are entering information into your PC 
and want to update your phone, click on the  icon to transfer the data. For 
more information on syncing your NeoPoint phone, refer to “Chapter 3: Syncing 
Your NeoPoint Phone” on page 59. For setting your NeoPoint to automatically 
sync your data, refer to “Setting Sync to Manual or Automatic” on page 86.

Did you know... you can extend your NeoPoint battery life by approximately 20% by 
setting and using the Power Save feature?

- The NeoPoint phone has a feature called Power Save. Once activated, the LCD 
will “go to sleep” 5 minutes after the last key was pressed, saving battery usage. 
For more information on Power Save, refer to “Enabling/Disabling Power 
Save” on page 87.

Did you know... you can set an alarm ringer to alert you before a scheduled 
appointment or wake you up while traveling?

- Using the Schedule application of your NeoPoint phone, you can set the phone 
to sound an alarm and notify you 5, 10, 15, etc. minutes prior to your meeting. 
In addition, if you are traveling, you can use this application to schedule an 
alarm to sound at a specified time in the morning (by scheduling an event) and 
wake you up. For more information on creating a scheduled event, refer to 
“Creating a Schedule Entry” on page 75.

Did you know... you can easily place a 3-way conference call?

- Your NeoPoint phone is capable of conferencing two other people on a call. For 
more information on making a 3-way conference call, refer to “Making a Three-
Way Call” on page 65.
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Did you know... you can easily redial with your NeoPoint?

- Redialing someone is as simple as pressing the SEND button twice. If you called 
someone and their line is busy and you want to dial the number again, press the 
SEND button. This will display the Call History screen. If the number is 
highlighted, press SEND again and the call will initiate. If the number is not 
highlighted, use the Navigator key to scroll to the number and press SEND. For 
more information on redialing a number or contact, refer to “Redialing” on page 
65.

Did you know... you can easily track your inbound and outbound calls with Call 
History?

- One of the applications your NeoPoint phone has is Call History. Call History 
tracks all incoming and outgoing phone calls. To view your Call History, from 
the Main menu, press Calls (Soft key1) and your Call History will be displayed. 
For more information on Call History, refer to “Using Call History” on page 73.

Did you know... you no longer need to use your PDA or appointment/ address book? 
Your NeoPoint replaces both!

- Your NeoPoint phone is the unique marriage of a cellular phone, PDA, and 
appointment book all in one. You no longer need to carry three different devices 
to meet your needs - just one - the NeoPoint!

Did you know... you can access the Internet with your NeoPoint?

- The MiniBrowser application of the NeoPoint phone allows you to access the 
Internet. You can surf specialized web pages that are designed specifically for 
use on a cellular phone. The world is at your fingertips - using your NeoPoint. 
For more information on using MiniBrowser, “Using MiniBrowser” on page 78.

NOTE: MiniBrowser is dependent on your carrier service. Refer to your car-
rier service provider for access and availability of MiniBrowser.

Did you know... your NeoPoint phone can tell which day of the week July 4, 2000 
falls on?

- By using the Schedule application in your NeoPoint phone, you can access dates 
years in advance. You are not limited to a calendar for anything. From the Main 
menu, press the Up Navigator key to access Schedule. Once in Schedule, press 
Month. Now use your Down Navigator key and scroll to whatever date you 
want. For more information on Schedule, refer to “Using Schedule” on page 75.
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Did you know... there is a Hands-Free Kit that allows you to drive safely and use 
your NeoPoint?

- If you must drive and use your NeoPoint, be safe and use a Hands-Free Kit 
accessory. This allows you to drive and talk without having to hold on to your 
phone. For more information on the Hands-Free Kit accessory, refer to “Hands-
Free Kit For Your Automobile” on page 106.

Did you know... whenever you see the Phone icon  in the upper right corner of the 
screen, you can make a call?

- The NeoPoint phone helps make it as easy as possible for you to make a call. 
Whenever the Phone icon is displayed, you can press the SEND key and make a 
call. If you are at a screen with several numbers in a list (for example, Contacts 
with home, work, fax, etc.) displayed, the NeoPoint will dial the first number on 
the list. To dial other numbers on the list, use the Navigator key to scroll to the 
number and then press SEND. For more information on the Phone icon, refer to 
“Onscreen Icons” on page 30.

Did you know... you can save a telephone number from Call History into Contacts?

- From the Call History application of your NeoPoint phone, you can save a 
number to Contacts. For example, let’s say that you receive an incoming call 
from an old friend you had not heard from in years. You did not have their 
number and you want to save it for future reference. After the call ends, access 
Call History. Highlight the number and press Options (Soft Key 2). Scroll to 
Save Number and press OK. This will transfer you to the Contacts application. 
Specify the type of number (home, work, fax, etc.) and enter the rest of the 
information. The number has been saved and a new contact established. For 
more information on saving a number from Call History, refer to “Saving a 
Number From Call History to Contacts” on page 73.
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Appendix A: Receiving and
Sending Fax and Data Calls

Overview

This chapter is designed to help you setup and use your NeoPoint phone as a wireless 
modem. To perform the procedures in this chapter, you must connect your NeoPoint 
phone to your PC using your SoftSync cable.

There are two sections discussed in this chapter: Fax and Data.

Although the two sections are similar, they require different procedures to properly 
complete the setup and transfer processes. Read each section thoroughly before 
beginning the procedures.

System Recommendations and Requirements

Windows NT, 95, or 
98

Windows 98 is recommended for best performance

NeoPoint-compatible 
modem program

Following is a list of NeoPoint-compatible programs:
Fax WinFax Pro™ 9.0 or later

HotFax™ 3.01 or later
Data HyperTerminal™ 1.0 or later

ProComm Plus® 32 4.7 or later
For a complete list of NeoPoint-compatible modem 
programs, visit www.neopoint.com.

IBM-compatible PC 486-class or faster

NeoPoint phone& 
SoftSync Cable

1
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Setting Up Your NeoPoint to Receive and Send a 
Fax

There are three sections for using your NeoPoint phone as a modem to send/receive a 
fax:

• Using WinFax Pro 9.0

• Using HotFax 3.01

• Using Other Fax Programs

Each section describing a specific fax program includes:

• Setup Procedures

• Receiving a Fax

• Sending a Fax

Using WinFax Pro 9.0

Setup Procedures

1. Ensure that your NeoPoint phone is connected to your PC and is powered ON.

2. Open WinFax Pro. 

NOTE:If you are unsure about setting up WinFax, refer to your 
WinFax documentation for specific instructions.

3. From the Tools pull-down menu, select the Setup command. The WinFax Pro 
Program Setup window will appear.

4. Select Modems and Other Fax Devices.

5. Click on PROPERTIES.

If your NeoPoint modem has not been setup or is not in the Connective Device 
list, you need to add it to the list. If it is setup - indicated by a check mark 
(active), skip to step 19.

6. Click on ADD... to install your NeoPoint modem. The Install New Modem Type 
window will appear.

7. Select Regular Modem as modem type and click on NEXT.

8. Click on NEXT and the system will attempt to detect your phone as a modem.
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9. Click on NEXT. A message stating Your modem has been setup successfully. 
will appear.

10. Clink on FINISH.

A pop-up window will be displayed stating standard modem has not been 
configured to work with WinFax Pro. Do you want to run the WinFax modem 
configuration wizard now?

11. Click on YES. The Modem Configuration Wizard - Ready to Test Modem 
window will appear.

12. Click on NEXT. WinFax Pro will detect your NeoPoint modem. 

13. Once detected, click on NEXT.

14. Select Class 2.0 Send/Receive Fax/Modem.

15. Click on NEXT.

16. Click on FINISH. The Select Locations for Standard Modem window will 
appear.

17. Click on OK. A pop-up window will appear asking Do you want to configure 
how this device dials when sending a fax?

18. Click NO.

19. When WinFax returns to the Modem and Other Fax Devices window, activate 
your modem device (standard modem) by selecting the Active box beside the 
name of the device. Click on PROPERTIES and select/check the following:

General Tab

Communication port = COMx (where x = 1, 2, etc.)

Baud rate = 2400 bps

Modem type = Class 2.0

Fax Tab

Hardware flow control (RTS/CRS)

20. Click on OK when ready.

21. Click on APPLY.

22. Click on CLOSE to exit the Modem and Other Fax Devices window.

23. Click on CLOSE.

24. Exit WinFax Pro, restart your PC, and re-open WinFax Pro program.
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Receiving a Fax

1. Ensure that your NeoPoint phone is connected to your PC and is powered ON.

2. Once the Main screen is displayed on your NeoPoint phone, press and release 
the POWER ON/OFF key to go to Quick Mode.

3. Using the NAVIGATOR key, scroll to Incoming.

4. Set Incoming mode to Fax In.

NOTE:Once you have set your NeoPoint phone Incoming Mode to 
Fax In, you cannot receive regular voice calls until you change 
Incoming Mode back to Voice.

5. In the WinFax Pro program on your PC, you need to setup the Answer mode. 
Click on RECEIVE and select one of the following:

Automatic Receive (recommended)

Manual Receive

Your NeoPoint modem is now ready for receiving an incoming fax.

Sending a Fax

NOTE:Your NeoPoint does not require that you change to Incoming 
mode - ensure that Incoming Mode is set to Voice.

To send fax, refer to your WinFax Pro documentation for specific instructions.

Using HotFax 3.01

Setup Procedures

1. Ensure that your NeoPoint phone is connected to your PC and powered ON.

2. Open the HotFax program.

NOTE:If you are unsure about setting up HotFax, refer to your 
HotFax documentation for specific instructions.

3. From the Setup pull-down menu, select the Modem... command. The Modem 
Setup window will appear.

4. Select Direct to COMx (where x represents the serial port connected to your 
NeoPoint modem).

5. Click on OK and exit HotFax.

6. Restart HotFax. HotFax will attempt to detect your NeoPoint modem. Once 
successfully detected, the HotFax Message Center window appears. 
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7. From the Setup pull-down menu, select the Modem... command. The Modem 
Setup window will appear.

8. Click on SETUP.

9. Click on the Fax tab and verify the following settings:

• Fax modem = Class 2.0

• Maximum speed for transmit & receive = 14400 bps

• Flow Control = Hardware (RTS/CTS)

Click on the Advanced Tab.

• Click on the Commands tab and clear the hardware flow control option.

10. Click OK.

11. Click OK.

12. Close and restart HotFax program. It may take several minutes for HotFax to 
detect your modem.

13. Once detected, HotFax and NeoPoint are ready for use.

Receiving a Fax

1. Ensure that your NeoPoint phone is connected to your PC and is powered ON.

2. Once the Main screen is displayed on your NeoPoint phone, press and release 
the POWER ON/OFF key to go to Quick Mode.

3. Using the Navigator key, scroll to Incoming.

4. Set Incoming mode to Fax In.

NOTE:Once you have set your NeoPoint phone Incoming Mode to 
Fax In, you cannot receive regular voice calls until you change 
Incoming Mode back to Voice.

5. To setup HotFax on your PC for Auto Answer mode, click on Setup pull-down 
menu and select the Preferences... command. The Preferences... window will 
appear.

6. Click on the Answer tab and verify that Normal answer is selected and Detect 
fax & data is selected in the pull-down menu. 

7. In the Answer Options section, select the number of rings desire. 

8. Select the Start Host on all data calls option (with a check mark).

Your NeoPoint modem is now ready for receiving an incoming fax.
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NOTE:Fax receives are stored in HotFax’s InBox directory and can 
be viewed under Mail/Log.

Sending a Fax

NOTE:Your NeoPoint does not require that you change to Incoming 
mode - ensure that Incoming Mode is set to Voice.

To send fax, refer to your HotFax documentation for specific instructions.

Using Other Fax Programs

For setting up other fax application program, refer to your fax program 
documentation for specific instructions.

Verify the following modem properties:

• Baud Rate: 2400 bps (default)

• Data Bits: 8

• Stop Bits: 1

• Parity: None

• Flow Control: Hardware (RTS/CTS)
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Setting Up Your NeoPoint to Receive and Send a 
Data File

There are three sections for setting up your NeoPoint phone to transfer data files:

• Using HyperTerminal 1.0

• Using ProComm Plus 9.0

• Using Other Data Transfer Programs

Each section describing a specific data transfer program includes:

• Setup Procedures

• Receiving a Data File

• Sending a Data File

Using HyperTerminal

Setup Procedures

1. Ensure that your NeoPoint phone is connected to your PC and powered ON.

2. On your PC/Laptop, open Control Panel and click on Modems to begin 
detecting your NeoPoint modem.

3. Click Add... from Modems Properties window and the Install New Modem 
window will appear.

4. Click Next.

Windows program tries to detect which type of modem and which COM port is 
connected to your NeoPoint phone.

When NeoPoint modem is successfully detected, the name Standard Modem is 
given.

5. Click Next when ready.

If your Windows program did not detect NeoPoint modem, verify:

• No other application is using the COM port assigned to the NeoPoint modem.

• Your NeoPoint phone is powered on and properly connected.

• Return to step 2 and begin process again.

6. Click Finish.

7. Open Control Panel and click on Modems.
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8. From Modems Properties window, select Standard Modem and click on 
Properties button.

9. Verify the following:

General Tab:

• Baud Rate: 19,200 bps (default)

Connection Tab:

• Data Bits: 8

• Stop Bits: 1

• Parity: None

Advanced Tab:

• Flow Control: Hardware (RTS/CTS)

10. Click OK when ready.

Receiving a Data File

On Your NeoPoint Phone:

1. Ensure that your NeoPoint phone is connected to your PC and is powered ON.

2. Once the Main screen is displayed on your NeoPoint phone, press and release 
the POWER ON/OFF key to go to Quick Mode.

3. Using the Navigator key, scroll to Incoming.

4. Set Incoming mode to Data In.

NOTE:Once you have set your NeoPoint phone Incoming Mode to 
Data In, you cannot receive regular voice calls until you change 
Incoming Mode back to Voice.

On Your PC/Laptop:

1. Open HyperTerminal.

2. Enter name and choose an icon for the connection.

3. Click OK. The Connect To window appears.

4. Under Connect Using, select the COMx (where x represents the serial port 
connected to your NeoPoint modem).

5. Click on OK.
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6. Verify the following communications port settings:

• Baud Rate: 19,200 bps (default)

• Data Bits: 8

• Stop Bits: 1

• Parity: None

• Flow Control: Hardware (RTS/CTS)

7. Type one of the following:

• ats0=x (where x = 1, 2, etc.) to automatically answer the incoming call

• ata when receiving a ring message to manually answer the incoming call

8. Press Enter.

9. File transfer can begin when the message CONNECT is displayed.

Sending a Data File - Manually

1. Start HyperTerminal.

2. On the Connection Description window enter a name and choose an icon.

3. Click OK. The Connect To window is displayed.

4. Set the Connect Using field to COMx (where x represents the serial port 
connected to your NeoPoint modem).

5. Click OK. The COMx Properties window is displayed.

6. Verify the following communications port settings:

• Baud Rate: 19,200 bps (default)

• Data Bits: 8

• Stop Bits: 1

• Parity: None

• Flow Control: Hardware (RTS/CTS)

7. Click OK.

8. Type atd followed by the phone number (e.g., atd2225558888) on the terminal 
window.

9. Press ENTER.

10. When the call has been connected, the message CONNECT is displayed.
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Sending a Data File - Automatically

1. From the File menu, select New Connection. The Connection Description 
window is displayed.

2. Enter a name and choose an icon.

3. Click OK.

4. Enter details of the phone number to be dialed.

5. Click OK.

6. Click DIAL to accept the default location.

7. File transfer can begin when the message CONNECT is displayed.
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Using ProComm Plus

Setup Procedures

1. Ensure that your NeoPoint phone is connected to your PC and is powered ON.

2. Once the Main screen is displayed on your NeoPoint phone, press and release 
the POWER ON/OFF key to go to Quick Mode.

3. Using the Navigator key, scroll to Incoming.

4. Set Incoming mode to Data In.

NOTE:Once you have set your NeoPoint phone Incoming Mode to 
Data In, you cannot receive regular voice calls until you change 
Incoming Mode back to Voice.

5. Open ProComm Plus. 

NOTE:If you are unsure about setting up your program, refer to 
your ProComm Plus documentation for specific instructions.

6. On Rapid Connect-Data selection bar, click on the drop-down menu and select 
Data.

7. From the Menu bar, open the Options menu, select Systems Options and then 
Modem Connection command. The Setup window will appear.

8. From the Current Modem/Connection selection bar, click on the drop-down 
menu and choose a COM port by selecting direct connect -COMx (where x is 
your COM port number).

9. Click on MODEM/CONNECTION PROPERTIES... The Modem/Connection 
Properties window will appear.

10. Verify the following settings:

• Baud Rate: 19200

• Parity: None

• Data Bits: 8

• Stop Bits: 1

11. Select (check mark) the option: Use hardware flow control

12. Click OK.

13. Click OK.
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If your NeoPoint phone is powered ON and connected to the correct PC COM 
port, the CTS indicator light on the bottom of the ProComm Plus screen should 
turn red. 

If it's not, verify your connection and COM port. After verification and the CTS 
light still does not light up, refer to your ProComm Plus documentation.

14. Type one of the following AT commands:

• ats0=x (where x = 1, 2, etc.) to automatically answer the incoming call

• ata when receiving a ring message to manually answer the incoming call

15. Press Enter.

16. Once the connection is established, you can begin transferring files.

Receiving a Data File

On Your NeoPoint Phone:

1. Ensure that your NeoPoint phone is connected to your PC and is powered ON.

2. Once the Main screen is displayed on your NeoPoint phone, press and release 
the POWER ON/OFF key to go to Quick Mode.

3. Using the Navigator key, scroll to Incoming.

4. Set Incoming mode to Data In.

NOTE:Once you have set your NeoPoint phone Incoming Mode to 
Data In, you cannot receive regular voice calls until you change 
Incoming Mode back to Voice.

On Your PC/Laptop:

NOTE:Ensure your baud rate/bits per seconds is set to 19200 for 
receiving data.

1. Type one of the following:

• ats0=x (where x = 1, 2, etc.) to automatically answer call

• ata when receiving a ring for manual answer

2. Press Enter.

3. File transfer can begin when the message CONNECT is displayed.
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Sending a Data File

NOTE:Your NeoPoint does not require that you change to Incoming 
mode - ensure that Incoming Mode is set to Voice.

Use your ProComm Plus to initiate data call.

For example, to manually make a data call type atd follow by the phone number, e.g., 
atd2225558888. 

When a call is established, a message stating CONNECT is displayed on the terminal. 
File transferring can now begin.

Select the name of data file where it is stored and the protocol that you want to send 
the file.

Using Other Data Transfer Programs

Setup Procedures

For setting up other data transfer programs, please refer to your data transfer program 
documentation for specific instructions.

Set the modem properties to the following settings:

• Baud Rate: 19200

• Data Bits: 8

• Stop Bits: 1

• Parity: None

• Flow Control: Hardware (RTS/CTS)

Receiving a Data File

On Your NeoPoint Phone:

1. Ensure that your NeoPoint phone is connected to your PC and is powered ON.

2. Once the Main screen is displayed on your NeoPoint phone, press and release 
the POWER ON/OFF key to go to Quick Mode.

3. Using the Navigator key, scroll to Incoming.

4. Set Incoming mode to Data In.

NOTE:Once you have set your NeoPoint phone Incoming Mode to 
Data In, you cannot receive regular voice calls until you change 
Incoming Mode back to Voice.
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On Your PC/Laptop:

NOTE:Ensure your baud rate/bits per seconds is set to 19200 for 
receiving data.

1. Type one of the following AT commands:

• ats0=x (where x = 1, 2, etc.) to automatically answer the incoming call

• ata when receiving a ring message to manually answer the incoming call

2. File transfer can begin when the message CONNECT is displayed.

Sending a Data File

NOTE:Your NeoPoint does not require that you change to Incoming 
mode - ensure that Incoming Mode is set to Voice.

Use your modem program to initiate data call.

For example, to manually make a data call type atd follow by the phone number, e.g., 
atd2225558888. 

When a call is established, a message stating CONNECT is displayed on the terminal. 
File transferring can now begin.

Select the name of data file where it is stored and the protocol that you want to send 
the file.



Appendix A: Receiving and Sending Fax and Data Calls

NeoPoint™ 1600 User’s Guide 129

AT Commands

Transferring data files requires you to use AT commands. The following tables list 
some of the more common AT Commands, S-Registers, and Basic Action 
Commands. For more AT commands, refer to your data transfer program 
documentation.

Table 1: Basic AT Parameters

Command Description

E0 Do not echo in command state or on-line command 
state.

E1 (default) Echo in command state or on-line command state.

Q0 (default) Return result codes.

Q1 Do not return result codes.

V0 Display result codes as numbers.

V1 (default) Display result codes as words.

Z0 (default) Reset to default configuration.

Table 2: Basic S-Registers

Command Value Description

S0 0 (default)
[1-255]

Disable automatic answering. 
[Enable automatic answering after (Value-
1) x 6 seconds.]

S6 2-10
2 (default)

Pause before blind dialing.

S7 1-255
50 (default)

Number of seconds to establish end-to-end 
data connection.

S8 0-255
2 (default)

Number of seconds to pause when ‘ is 
encountered in dial string.
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Table 3: Basic Action Commands

Command Description

A/ Re-execute previous command.

A Enter on-line state.

H0 Causes the MT2 to transition from on-line command state to 
command state. Use the digit “0” is optional

O0 Causes the MT2 to transition from on-line command state to on-
line state. Use the digit “0” is optional
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Appendix B: Using the
MiniBrowser

Overview

The MiniBrowser allows the user to use a variety of Internet services. Using 
the MiniBrowser on the NeoPoint phone allows you to:

• Send and receive Internet e-mail

• Browse and search the World Wide Web via web pages specially 
designed for cellular customers

• Set bookmarks to directly access your favorite sites

• Retrieve information such as stock quotes and flight schedules from the 
Internet

How the MiniBrowser System Works

When you connect to the MiniBrowser from your NeoPoint, a signal (request 
for information) is sent to your provider’s cellular network. From the cellular 
network, your request is sent to the UP.Link gateway (portal to the Internet). 
The UP.Link gateway accesses the Internet and retrieves your requested 
information.

Private Network
or 

Internet 

NeoPoint
UP.Link Gateway

Cellular
Network

1
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Accessing the MiniBrowser

1. From the Main screen, press the Left Navigator key and the MiniBrowser Main 
Access window will appear.

2. Your NeoPoint phone will access the MiniBrowser network. Once connected, 
press and momentarily hold the BACK key and the window will change to the 
Home Menu page.

To access the Home page from any menu in the MiniBrowser, press and 
momentarily hold the BACK key.

Left Navigator Key

UP.Browser Main Access Window

Soft Keys

Marker

Header & Status

Home Menu Page
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The Home menu has four parts:

• Header

• Marker

• Menu Options

• Soft Keys and Status

Header Displays page header and status information

Marker Move to select an option and press OK (Soft Key 1)

Menu Options Lists options, menus, etc. for current page

Soft Keys Displays command options

At the bottom of the display, you will see commands to select. In this window, the 
commands are OK (Soft Key 1) and Menu (Soft Key 2). Once you select an option, 
press one of the Soft Key commands. If you choose OK (Soft Key 1) to view cursor 
arrow selection, the status line will change from OK to Sending >>>. There is a 
momentary delay as your request for information is accessed and returned to your 
NeoPoint phone.

Using E-mail

Your NeoPoint phone uses the MiniBrowser e-mail service, a fully integrated two-
way messaging system. This system allows you to send and receive messages to 
anyone who has a valid Internet address with a user name and domain name.

Accessing E-mail

Retrieving and Reading E-mail

Replying to an E-mail

Forwarding an E-mail

Accessing E-mail

From the Home page, navigate to the location of the e-mail menu item on 
your phone, then, if necessary, press the OK (Soft Key 1).

The E-mail Inbox appears.

If the E-mail Inbox does not appear, you will receive a message asking you to create 
an account. You can use the E-mail Inbox to read your messages and compose new 
messages. You should confirm your e-mail name and address to ensure accuracy.
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Confirming Your E-mail Name and Address

An e-mail name is a user name or nickname for receiving e-mail. Your e-mail name 
is used as the first portion of your phone’s Internet e-mail address, preceding the @ 
symbol and the domain name.

Your wireless network operator normally gives you an e-mail name when your 
account is created. To view your e-mail name:

1. From the E-mail Inbox, press Menu (Soft Key 2).

2. From the Menu, scroll & select Settings.

3. Press OK (Soft Key 1).

The Settings menu appears. Your e-mail name appears in brackets next to e-mail 
name.

4. Scroll and select E-mail Address. If necessary, press View (Soft Key 2).

Your e-mail address is shown in the display.

yourname@yourdomain.com

Retrieving and Reading E-mail

To retrieve and read an e-mail:

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.

The E-mail Inbox lists the nine most-recent messages. A new/unread e-mail is 
indicated by a bullet next to the e-mail.

3. Use the Navigator key (up/down) to scroll through the list of e-mails. The 
marker indicates the selected e-mail.

4. Press View (Soft Key 1) to retrieve and read an e-mail.

Each e-mail on the list has a corresponding number. Press the corresponding 
number (on the key pad) to view the e-mail message.

The text of the message appears, showing who the message is from (in brackets) 
and the subject line. 

If the message is longer than the display, press the Navigator key (down) to read 
the rest of the message.

Press the Navigator key (down) to activate the Info menu. 
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Info is used to retrieve when the message information, i.e., sender’s name, 
e-mail address, etc.

5. Press OK (Soft Key 1) to return to the message.

Two options appear at the bottom of the message: Next E-mail and Respond. 

• Press Next (Soft Key 1) or 1 (on the key pad) to display the next e-mail.

• Press 2 (on the key pad) to reply to the e-mail.

• Press Menu (Soft Key 2) to display a list of options, including replying, 
forwarding, saving, and faxing the message.

When the Respond option is selected, the Respond menu is displayed.

When the Reply or Reply All options are used, the phone automatically 
creates a new message addressed to the sender or senders of the original 
message.

Replying to an E-mail

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.

3. Use the Navigator key (up/down) to select the desired message.

4. Press View (Soft Key 1).

5. Press Respond (Soft Key 2).

6. Select Reply or Reply All.

7. Press OK (Soft Key 1). The Message screen appears.

8. Enter the text of your reply.

9. Press Next (Soft Key 1) to confirm the message. The Confirm screen is 
displayed to confirm the correct address. CC option can be added and the 
subject of the message can be edited at this time.

10. If all the information is correct, press Send (Soft Key 2).

Composing an E-mail

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The MiniBrowser Inbox will appear.

3. Press Menu (Soft Key 1).

4. Select Compose.
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5. Press OK (Soft Key 1).

6. Enter or lookup the e-mail address.

7. Press OK (Soft Key 1). The Subject screen appears

8. Enter the subject of the message.

9. Press Next (Soft Key 1). The Message screen appears.

10. Enter the text of the message.

11. Press Next (Soft Key 1). The Confirm screen appears.

12. Press Send (Soft Key 2) to send the message.

Forwarding an E-mail

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.

3. Press Menu (Soft Key 1).

4. Select Respond.

5. Press OK (Soft Key 1).

6. Select Forward.

7. Press OK (Soft Key 1). The Forward screen appears.

8. Enter or lookup the e-mail address.

9. Press OK (Soft Key 1).

10. Edit the Subject line if desired.

11. Press Next (Soft Key 1). The Message screen appears.

12. Enter the text of the message.

13. Press Next (Soft Key 1) to confirm the message. The Confirm screen is 
displayed to confirm the correct address. Carbon copies (CC) can be added and 
the subject of the message can be edited at this time.

14. If all the information is correct, press Send (Soft Key 2).

Deleting an E-mail

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.
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3. Select the message to be deleted.

4. Press Menu (Soft Key 2).

5. Select Delete.

6. Press OK (Soft Key 1).

Saving an E-mail

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.

3. Select the message to be saved.

4. Press Menu (Soft Key 2).

5. Select Save Message.

6. Press OK (Soft Key 2).

E-mail Settings

There are several settings for controlling how e-mail is sent and received.

Viewing an E-mail Address

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.

3. Press Menu (Soft Key 2).

4. Select Settings.

5. Press OK (Soft Key 1).

6. Select Email Address

7. Press OK (Soft Key 1). The e-mail address is shown in the display.

Specifying an E-mail Name

E-mail name refers to the portion of the e-mail address that precedes the @ symbol. 

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.

3. Press Menu (Soft Key 2).

4. Select Settings.
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5. Press OK (Soft Key 1).

6. Select Email Name.

7. Press Edit (Soft Key 1).

8. Enter the new e-mail name to be used.

NOTE:Only the following characters are allowed: letters a–z, 
numerals 0–9, period (.), hyphen (-), underscore (_).

9. Press OK (Soft Key 1).

Specifying a Person’s Name 

When an e-mail message is sent, the person’s name (e.g., John Doe) automatically 
appears in parentheses after the e-mail address. 

To specify a person’s name:

1. Use the Navigator key (up/down) to select Email from the Home menu.

2. Press OK (Soft Key 1). The E-mail Inbox will appear.

3. Press Menu (Soft Key 2).

4. Select Settings.

5. Press OK (Soft Key 1).

6. Select Name.

7. Press Edit (Soft Key 1).

8. Enter the name.

9. Press OK (Soft Key 1).
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Exiting E-mail

Press Home (Soft Key 2) to go to the Home menu or press the Back key until the 
Home menu appears.

Web Sites

Web sites may vary from carrier to carrier. Your actual list may vary from the 
following example. Contact your carrier service provider for more information 
regarding web site availability and access.

MiniBrowser displays an alert icon on the NeoPoint Main screen when a new alert 
has been received in the Inbox. 

Select the item by pressing the Navigator key (up/down) to position the > symbol in 
front of the option, or press the corresponding number on the keypad. Press the BACK 
key to return to the previous menu.

Searching for Web Sites and Services

To search for a particular web site or service:

1. From the Web Sites menu, use the Navigator (up/down) key to select Info-
Search.

2. Press the OK (Soft Key 1) to display the Info-Search menu.

3. There are three options for searching:

• InfoSpace

• WhoWhere

• Mobile Directory
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InfoSpace

When you select InfoSpace, the InfoSpace Lookup menu appears. Scroll and select 
one of the following options:

• People

• Business

• Yellow Pages

• Reverse Phone

• 800 Number

• E-mail

• Fax

• Int’l

WhoWhere

When you select WhoWhere, the WhoWhere? menu appears. Scroll and select one 
of the following options:

• E-mail Search

• Phone Search

Mobile Directory

When you select Mobile Directory, the Welcome to Mobile Directory window 
appears. Use the Navigator key to scroll the window and view the directory 
information. Mobile Director can search for:

• Mobile Numbers

• Pager Numbers

• Fax Numbers

• E-mail Addresses

Selecting Other Categories From Web Sites Menu

Because the carrier service provider specifies which categories are displayed, your 
actual list may vary. Accessing the categories is accomplished by scrolling and 
selecting the menu item, much like the InfoSearch feature. For a complete list of 
Categories available to you, contact your carrier service provider.
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Using Bookmarks

Creating a Bookmark

1. Go to the service or screen you want to add to your Bookmark list.

2. Press the MAIN/MENU key or press and momentarily hold the #SPACE 
key on your NeoPoint phone.

If the screen has a title, the MiniBrowser software automatically supplies a 
name based on the name of the screen you are viewing.

If you want a different or shorter name, you can change the bookmark name at 
this point. Use the NAVIGATOR and CLR keys to change the name.

3. Press Submit (Soft Key 1).

4. A message appears confirming that the bookmark was added to the list.

5. Press OK (Soft Key 1) again to return to the screen you bookmarked.

The new bookmark is added to the end of the Bookmark list.

Going to a Bookmark

1. From the Home menu, choose Bookmarks, then, if necessary, press OK 
(Soft Key 1).

2. Choose the bookmark you want and, if necessary, press OK 
(Soft Key 1).

Deleting a Bookmark

1. From the menu of Bookmarks, choose the bookmark you want to delete 
and press Menu (Soft Key 2).

2. Choose Delete from the list of menu items (or press 3 on the NeoPoint 
key pad).

A confirming message asks if you’re sure you want to delete the named 
bookmark.

3. 3. Press Yes (Soft Key 1) to delete the bookmark.
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